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c h a p t e r  1

About CallPilot

This chapter introduces CallPilot, the powerful multimedia messaging system 
from Nortel Networks. CallPilot offers a single solution for managing many 
types of information, including voice mail, fax-mail, e-mail, telephone calls, 
conferencing, calendars, directories, and call logs.

CallPilot enables you to get all the information you need from one source, 
whether through display-based telephone sets, your wireless set, your Windows 
desktop computer, a speech recognition interface, or another personal 
communications device. 

In this chapter 
About this guide 13

Finding your way around CallPilot 25
Integrated AMIS Networking Implementation and Administration Guide 11
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Overview

Introduction
The Integrated AMIS Networking Implementation and Administration Guide 
provides the information and procedures that are necessary to implement the 
Integrated Audio Messaging Interchange Specification (AMIS)  Networking.

Assumptions
This guide assumes that the Meridian Application Server has been correctly 
installed and is operational. If the application has not been installed, then install 
it before proceeding. For installation instructions, refer to the hardware 
installation guide appropriate to your server type.

If the server has been installed but is not operational, refer to the Maintenance 
and Diagnostics Guide for information on troubleshooting your system.
14 CallPilot
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Skills you need

Introduction
You need certain skills and knowledge to use this guide effectively.

Nortel Networks product knowledge
Knowledge of, or experience with, the following Nortel Networks products will 
assist you:

■ previous releases of CallPilot

■ Meridian Mail

PC experience or knowledge
Knowledge of, or experience with, the following PC products will be of 
assistance. This guide does not document the following functionality:

■ Microsoft Windows NT

■ Microsoft Windows 95

■ Microsoft Windows 2000

Other experience or knowledge
Other types of experience or knowledge that may be of use include the 
following:

■ switch configuration and operation (especially trunk group access 
restrictions [TGARs] and network classes of service [NCOS])

■ network management

■ client-server systems

■ flowcharting

■ troubleshooting
Integrated AMIS Networking Implementation and Administration Guide 15
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How this guide is organized

Introduction
The Integrated AMIS Networking Implementation and Administration Guide is 
organized in the sequence of tasks required to successfully implement Integrated 
AMIS Networking for CallPilot. Start at the beginning of the guide and work 
your way through it until all required tasks are completed.

Contents
This guide contains the following chapters.

Chapter title Description

Chapter 1, About CallPilot This chapter describes how to work with the 
CallPilot interface and how to use this guide.

Chapter 2, Getting started This chapter provides an overview of 
Integrated AMIS Networking.

This chapter describes the features supported 
by Integrated AMIS Networking and how 
Integrated AMIS Networking works.

This chapter also provides a high-level 
overview of the tasks that are performed 
during implementation.

Chapter 3, Gathering information This chapter explains how to gather the 
information required to implement Integrated 
AMIS Networking.

Chapter 4, Configuring the switch for 
Integrated AMIS Networking

This chapter explains how to configure the 
switch for Integrated AMIS Networking.

Chapter 5, Configuring CallPilot for 
Integrated AMIS Networking

This chapter describes how to configure 
CallPilot for Integrated AMIS Networking.

This chapter describes every box that must be 
completed and provides detailed procedures.
16 CallPilot
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Chapter 6, Adding sites to Integrated 
AMIS Networking

This chapter describes how to configure the 
local site. This chapter also describes how to 
add and configure every site in the messaging 
network that uses Integrated AMIS 
Networking to exchange messages with local 
sites.

This chapter describes every box that must be 
completed and provides detailed procedures.

Chapter 7, Testing and backing up 
Integrated AMIS Networking

This chapter describes how to test the 
implementation of Integrated AMIS 
Networking to ensure that it is properly 
configured. This chapter also describes how 
to perform a backup of the system.

Chapter 8, Maintaining Integrated AMIS 
Networking

This chapter explains how to perform both 
regularly scheduled maintenance tasks and 
as-required maintenance tasks.

Chapter 9, Troubleshooting Integrated 
AMIS Networking

This chapter provides information to identify 
and solve problems with Integrated AMIS 
Networking.

Chapter title Description
Integrated AMIS Networking Implementation and Administration Guide 17
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Related information products

Introduction

The following CallPilot technical documents are stored on the CD-ROM that you 
receive with your system. The documents are also available from the following 
sources:

■ CallPilot Manager 

■ My CallPilot

■ the Nortel Networks Partner Information Center (PIC) at 
http://my.nortelnetworks.com

You require a user ID and a password to access the PIC. If you do not have a PIC 
account, click Register to request an account. It can take up to 72 hours to 
process your account request.

You can print part or all of a guide, as required.

Note: To order the documents that are available in printed format, contact your 
Nortel Networks sales representative.

Planning and migration guides

Use these guides before you install CallPilot to help plan your system, or to plan a 
migration of data from Meridian Mail to CallPilot: 

Document title NTP number

Installation and Configuration Planner —

Planning and Engineering Guide 555-7101-101

What’s New Guide 555-7101-901
18 CallPilot
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Installation and configuration guides

The following guides describe how to install the following: 

■ CallPilot server hardware and software

■ desktop messaging and My CallPilot software 

Administration guides

The following guides provide specialized information to help you configure 
administer and maintain CallPilot, and use its features: 

Document title NTP number

Desktop Messaging and My CallPilot 
Installation Guide

555-7101-505

Installation and Configuration Guide for your server 
model 

This is a binder that contains the following five 
documents:

■ Part 1: Installation and Maintenance Overview

■ Part 2: <Server model> Server Hardware 
Installation

■ Part 3: <Switch name> and CallPilot Server 
Configuration

■ Part 4: Software Installation and Maintenance

■ Part 5: <Server model> Server Maintenance 
and Diagnostics

Refer to the 
CallPilot 
Installation and 
Configuration 
binder for NTP 
numbers.

Document title NTP number

Administrator’s Guide 555-7101-301

Reporter Guide 555-7101-310

Application Builder Guide 555-7101-325
Integrated AMIS Networking Implementation and Administration Guide 19
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Networking guides

The following guides describe how to plan, install, set up, and troubleshoot the 
CallPilot networking services: 

Note: For instructions on how to configure the networking services on CallPilot, 
refer to the CallPilot Manager online Help.

Desktop Messaging and My CallPilot Administration 
Guide

555-7101-503

Meridian Mail to CallPilot Migration Utility Guide 555-7101-801

Document title CallPilot release NTP number

Networking Enhancements Guide 2.0 555-7101-507

Networking Planning Guide 1.0 555-7101-100

NMS Implementation and 
Administration Guide

1.0 555-7101-302

AMIS Networking Implementation 
and Administration Guide

1.0 555-7101-303

Enterprise Networking 
Implementation and Administration 
Guide

1.0 555-7101-304

Integrated AMIS Networking 
Implementation and Administration 
Guide

1.0 555-7101-305

VPIM Implementation and 
Administration Guide

1.0 555-7101-306

Document title NTP number
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End user guides

The following guides are intended for CallPilot end users, such as telephone set 
users and desktop messaging users:

Document titles

Unified Messaging Quick Reference Card

Unified Messaging Wallet Card

Unified Messaging What’s New Card

Command Comparison Cards

Menu Interface Quick Reference Card

Alternative Command Interface Quick Reference Card

Multimedia Messaging User Guide

Speech Activated Messaging User Guide

Desktop Messaging User Guides

My CallPilot User Guide
Integrated AMIS Networking Implementation and Administration Guide 21
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Troubleshooting

The CallPilot Troubleshooting Reference describes symptoms that can appear on all 
CallPilot server platforms, and describes ways to resolve them. 

The CallPilot Troubleshooting Reference is intended for Nortel Networks 
distributors and technical support representatives; therefore, it is not part of the 
customer documentation package. Nortel Networks continually updates the 
CallPilot Troubleshooting Reference, which is available from the Nortel Networks 
Partner Information Center (PIC) at http://my.nortelnetworks.com.

You require a user ID and a password to access the PIC. If you do not have a PIC 
account, click Register to request an account. It can take up to 72 hours to process 
your account request.

Note: If you are not a Nortel Networks distributor, then contact your Nortel 
Networks technical support representative for assistance.

Using online sources

CallPilot administration online Help
The CallPilot Manager and CallPilot Reporter software contain administration 
online Help areas that provide access to 

■ technical documentation in Acrobat PDF format

■ online Help topics in HTML format

To access online information, use either of the following methods:

■ Click the orange Help button at the top of any page to access the Administration 
Help area. 

■ Click the grey Help button on any page to display a topic that relates to the 
contents of the page. 

For more information about using these Help systems, access the CallPilot Manager 
Help, open the Getting Started book, and click “Navigating CallPilot Manager 
Help.”

The Application Builder software contains a Windows Help system as well as 
context-sensitive Help (available by clicking the ? button and then a field or label).
22 CallPilot
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CallPilot end-user online Help
The My CallPilot software contains a Useful Information area that provides access 
to the end-user guides in PDF format. 

To access online Help for the currently selected My CallPilot tab, click the Help 
button on the upper-right corner of the My CallPilot page. 

Desktop messaging provides product-specific Windows Help for groupware 
clients (Microsoft Outlook, Novell GroupWise, and Lotus Notes). The stand-alone 
version of CallPilot Player also provides addressing and troubleshooting 
information for Internet mail clients.

Contacting technical support

Contact your distributor’s technical support organization to get help with 
troubleshooting your system.
Integrated AMIS Networking Implementation and Administration Guide 23
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Conventions

Commands documented in procedures
As in many other Windows-based applications, in CallPilot you can execute a 
command in several ways.  For example, to copy text you can choose any of the 
following methods:

■ Select Copy from the Edit menu.

■ Click the Copy button on the toolbar.

■ Type the keyboard shortcut Control + C.

The procedures in this guide use only the first method: selecting a command 
from a menu.

Navigation information in procedures
A Getting there statement precedes each procedure in this guide.  This 
statement summarizes the steps you must take to navigate to the window or tab 
where you carry out the procedure.

All Getting there statements start at the Nortel System Management 
Interface (SMI) window.  This assmues that you logged on and selected the 
appropriate system.  Eac item mentioned after the Nortel SMI window 
represents an icon, window or tab that makes up the path to the final destination.

Example
To define special mailboxes, such as the broadcast mailbox, you must be on the 
Mailboxes tab.  

Getting there  Nortel SMI > Meridian Application Server > CallPilot > Message 
Administration

After you double-click Messaging Administration, the Message Administration 
Properties sheet displays.  Click the Mailboxes tab.
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Finding your way around CallPilot

In this section
Connecting to CallPilot 26

Multi-administrator access 34

Error handling in property sheets 36

Using the online Help 39
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Connecting to CallPilot

Introduction
To perform administrative tasks, or to build or work with CallPilot applications, 
you must first connect to the Meridian Application Server (the MAS server). 
The MAT Navigator and the System Management Interface (SMI) work together 
to give you access to your system and sites.

Selecting a system-the MAT Navigator
The first step in logging in is to launch the MAT Navigator, which has its own 
password. The MAT Navigator connects your administration client to the MAS 
server. It displays all your sites and systems and enables you to select one to 
work on.
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Selecting a program—the System Management Interface (SMI)
When you select a system from the MAT Navigator, you are prompted for a 
second password. At this point, the SMI window for the selected system or site 
displays.
Integrated AMIS Networking Implementation and Administration Guide 27



About CallPilot  Standard 1.0
The SMI gives you quick and easy access to your system or sites. The SMI uses 
a navigation tree to display the system's hierarchy. In the tree, icons represent the 
folders and programs. Double-click a folder icon to view its contents. Folders 
can contain programs and other folders. Double-click a program icon to run the 
associated program.

Selecting an object-list views
When you launch certain programs, the first thing you see is a list view. The list 
view displays all the objects of a certain type (such as mailbox classes) that are 
currently defined in the system. The list view includes predefined objects as well 
as those defined by an administrator. From the list view window, you can select 
a specific object to work on.
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Viewing and changing properties
Select an object and display its properties by

■ double-clicking it or

■ single-clicking it and selecting Properties from the File menu

■ right-clicking it and selecting Properties from the popup menu

Entering data and choosing options-property sheets
A property sheet is displayed when you view an object selected from a list view. 
Certain programs, such as Messaging Administration, display a property sheet 
immediately after launching. Property sheets have one or more tabs. Each tab 
has fields, referred to as boxes, in which you can type data or from which you 
can select options.
Integrated AMIS Networking Implementation and Administration Guide 29



About CallPilot  Standard 1.0
Most CallPilot property sheets look like the following:
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Some property sheets are divided into two panes. When a box is checked in the 
left pane, the selected capabilities are enabled and you can access the associated 
tabs. Select a tab by clicking its name in the left pane or by clicking the tab in the 
right pane. These property sheets look like this:

Mandatory boxes
If the name of a box is underlined, the box is mandatory, and you must fill it in. 
You cannot save if any mandatory boxes are empty.
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Common buttons
The following buttons appear on most property sheets:

Using the toolbar buttons
For easier access, some of the more common tasks, such as Print and Save, are 
represented as buttons on the toolbar.

The following buttons are used throughout CallPilot. Buttons or icons specific to 
certain CallPilot functions, such as backups and archives, are documented in the 
relevant chapters.

Button Description

Save Saves all changes made on any of the tabs in a property 
sheet and closes the property sheet. Therefore, save only 
when you have made the necessary changes on all tabs.

Cancel Closes the property sheet without saving any changes. 

Print Prints the contents of all tabs in the property sheet.

Help Displays Help for the current tab. From this overview 
Help topic, you can access other Help topics, the index, 
and the search function.

Toolbar button Description

Saves any changes you have made and then transfers 
all the application's data to the server.

Opens the Print dialog box and prints the active file or 
the objects you specify.

Deletes the object you select.
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Displays the properties of the object you select.

Displays the Help topics window.

Explains the next menu item or screen object you 
click. In a window, there is an arrow. On tabs or in 
dialog boxes, there is no arrow.

Opens the New dialog box, where you identify the 
properties of the object you are creating. The button 
looks different in different applications.

Displays the Open dialog box, where you select an 
object to open. The button is different in different 
applications.

Reloads the current page and displays the changes you 
have made.

Enables you to select how the system displays icons.

Toolbar button Description
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Multi-administrator access

Introduction
You can create multiple administrator accounts to make administering CallPilot 
easier and more efficient. Multiple accounts enable administration 
responsibilities to be distributed among a number of people. Therefore, certain 
administrators can specialize in certain tasks, such as maintaining users, 
performing backups, analyzing reports, or creating multimedia services.

Access classes
For security reasons, administrators should be given access only to those parts of 
the system that relate to their role. For example, an administrator who is 
responsible only for creating multimedia services should have access only to 
Application Builder and the Service Directory Number Table.

Each administrator account is assigned an access class. An access class is a list 
of the parts of the system and the level of access allowed. The access levels are 
as follows:

■ create/delete (enables an administrator to delete objects such as users and 
services)

■ edit

■ view

■ none

For example, an administrator may be able to create or delete objects in 
Application Builder but only view User Templates.
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Simultaneous access
Multiple administrators can log in to CallPilot at the same time without 
overwriting other work.

If you are the first to log in to a particular resource, such as a specific mailbox 
class or user profile, and another administrator tries to access the same resource, 
a dialog box appears to inform you of the other administrator. At this point, you 
can do one of the following:

■ Keep editing.

■ Save your changes, and release the resource to the other administrator.

■ Cancel your changes, and release the resource to the other administrator.

If you do not respond to this prompt within two minutes—because you are away 
from the terminal, for example—the system releases the resource so that others 
can access it. If this happens, all your unsaved changes are lost.

An administrator who accesses a resource that is currently being edited sees a 
read-only view of the property sheet in which all boxes are dimmed. This 
indicates that the resource is currently locked. The administrator is not notified 
when the resource is released, but must try to access the property sheet again to 
see whether its status has changed.

If a user tries to log on to a mailbox while an administrator is changing the 
profile, the user is unable to log on and receives a message that says the mailbox 
is in use.

Refreshing screens
Because multiple administrators can access the same database at the same time, 
a Refresh command is available from the View menu to ensure that the view you 
are seeing is the most up-to-date.

For example, if you are viewing a list of users when another administrator 
deletes a user, the only way to see the change is to refresh the screen. You 
should, therefore, refresh the screen regularly.
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Error handling in property sheets

Introduction
If you make certain types of errors while entering data, you are not able to save 
your changes until you correct the errors. For example, if you leave a mandatory 
box empty, you receive a message prompting you to fix it.

Note: These errors do not show up in the Event Browser or Alarm Monitor 
because the errors relate only to data entry and are not operational problems.

How error handling works
There are two types of error messages.

Type 1
If you get this type of error message, click OK, and then fix the problem 
described in the message before you try to save again.
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Type 2
If you get this type of error message, click OK to see a list of errors.

Double-click an error from the list. Your cursor is automatically placed in the 
box where the error was made so that you can correct it.
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For example, if you double-click the second error, the Remote notification tab is 
displayed, with the cursor in the Target number box.
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Using the online Help

Introduction
While administering or maintaining CallPilot, you may have questions about the 
purpose of certain boxes and buttons, or need more information about 
completing certain tasks. Online Help provides brief answers to the questions 
"What's this?" and "How do I...?"

Context-sensitive Help
If you need to know the purpose of a particular box or button, use 
context-sensitive Help.
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To access context-sensitive Help

1 Click the  icon in a window or the  icon on a tab or in a dialog 
box.

2 Point to the box or button for which you want more information, and click.

Result: A pop-up description of the selected object is displayed.
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Procedures
If you need to know how to do something, you can access procedures to lead 
you through a task.

High-level tasks
In some cases, high-level tasks take you through longer procedures. These tasks 
also provide you with navigation to the step-by-step procedures they include.

For example, setting up Delivery to Telephone requires several procedures. The 
high-level task summarizes these procedures. You click the gray buttons within 
the task to open the step-by-step procedures. The high-level task remains on 
your screen so that you can continue to use it to move through the procedures.
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Overview topics
Overview topics provide brief descriptions of tabs, features, and the tasks 
carried out from the tabs. However, the online guides contain more detailed 
feature descriptions.

To access overview topics
Click the Help button on a tab.

To find information in Help
You can look up procedures and overview topics in the following ways:

1 From the Help menu, select Help Topics.

Note: You can also press F1 on the keyboard.

2 Go to one of the following tabs:

■ To see the table of contents of all the Help topics, select the Contents 
tab.

■ To look up a subject alphabetically, select the Index tab.

■ To do a full-text search to find topics that contain the words you enter, 
select the Find tab.
42 CallPilot



c h a p t e r  2

Getting started

Integrated AMIS Networking is one of the networking solutions offered by 
CallPilot. Integrated AMIS Networking uses the industry-standard AMIS analog 
protocol to exchange messages with AMIS-compliant systems that are 
configured in the local network database.

This chapter introduces Integrated AMIS Networking and provides a basic 
overview of the Integrated AMIS Networking implementation process.

In this chapter 
About Integrated AMIS Networking 45

Implementing Integrated AMIS Networking 55

How Integrated AMIS Networking works 61

How Integrated AMIS Networking handles messages 73

Coordinating with the system administrator 81
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About Integrated AMIS Networking

In this section
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CallPilot and Integrated AMIS Networking 51
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Overview

Introduction
Integrated AMIS Networking is one of the networking solutions offered by 
CallPilot. This chapter introduces Integrated AMIS Networking and provides a 
basic overview of its implementation process.

You must be familiar with the basic concepts of messaging networks, dialing 
plans, and protocols. To review these concepts, consult the Networking Planning 
Guide.

Definition: Integrated AMIS Networking
Integrated AMIS Networking is a CallPilot networking solution that is used to 
exchange messages between users at different sites in a private messaging 
network.

The following diagram is a conceptual illustration of how Integrated AMIS 
Networking works.
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AMIS protocol
Integrated AMIS Networking uses the industry-standard analog Audio 
Messaging Interchange Specification (AMIS) protocol. Because it is standard 
protocol, AMIS can exchange messages with all AMIS-compliant messaging 
systems, regardless of vendor.

The AMIS protocol uses dual-tone multifrequency (DTMF) signaling. DTMF 
signaling is a global standard. Therefore, you can use Integrated AMIS 
Networking outside of North America.

Note: There are both analog and digital versions of the AMIS protocol, but 
CallPilot uses only the analog version. Therefore, AMIS refers to AMIS-Analog 
throughout this guide.

Comparison with AMIS Networking
AMIS Networking is another networking solution offered by CallPilot. This 
solution also uses the AMIS protocol.

AMIS Networking is designed primarily for the exchange of messages with sites 
that are not part of the private messaging network. When a site is not included in 
the private messaging network, it is called an open site.

Integrated AMIS Networking, however, is used to exchange messages with sites 
that are part of the private messaging network. When a site is included in the 
private messaging network, it is called an integrated site.

Because Integrated AMIS Networking uses the AMIS protocol, it can also be 
used to send messages to open sites.
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Key terms
The following terms are used throughout this guide:

Note: The term “virtual node,” which was used in Meridian Mail 
documentation, is replaced by the term “integrated site.” 

Relationship with AMIS Networking
The capability to exchange messages with open sites is inherent within 
Integrated AMIS Networking. That is, if you have Integrated AMIS Networking 
implemented on your local site, local users can send messages to other sites 
within the private messaging network, as well as to open sites.

Term Definition

Open ■ Not defined in the network database

■ Not part of the private messaging network, in 
most cases

Integrated ■ Defined in the network database

■ Part of the private messaging network

Network administrator ■ Individual responsible for implementing and 
maintaining a site in the private messaging 
network
48 CallPilot



October 2003 Getting started 
Complex network with Integrated AMIS Networking
You can implement Integrated AMIS Networking on a complex messaging 
network that combines several networking solutions. A messaging network is 
often both open and private, combining various protocols.

The following diagram illustrates a complex network that includes Network 
Message Service (NMS), Enterprise Networking, AMIS Networking, and 
Integrated AMIS Networking. 

Because Enterprise Networking is implemented in this messaging network, 
every site has a unique site ID number.

While the sites have more than one networking solution implemented, only one 
protocol is used between any two sites (for example, Site 4 and Site 2 must agree 
on which protocol to use).

In this example, Site 1 implements VPIM Networking to exchange messages 
with an open site. Since the VPIM protocol is not used by Site 1 to communicate 
with any other site within the private messaging network, Site 1 does not 
implement Integrated AMIS Networking.
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When to use this guide
Use the Integrated AMIS Networking Implementation and Administration Guide 
if you use the AMIS protocol to exchange messages with integrated sites. You 
can also use this guide if you use the AMIS protocol to exchange messages with 
open sites.

If you use the AMIS protocol to exchange messages with open sites only, use the 
AMIS Networking Implementation and Administration Guide.
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CallPilot and Integrated AMIS Networking

Introduction
Integrated AMIS Networking supports most of the features offered by CallPilot.

Integrated AMIS Networking features
The following table lists the CallPilot features that are supported by Integrated 
AMIS Networking.

For detailed information about CallPilot features, consult the Basic 
Administration Guide.

CallPilot feature Supported Notes

Call Sender Yes Call Sender can be used for both call 
answering and composed messages from 
Integrated AMIS Networking users if

■ the mailbox numbering plan follows the 
dialing plan, or

■ a remote user is added for the network 
user

Names Across the Network No

Name Addressing Yes This feature is available if users at the 
remote site are defined as remote users at 
the local site.

Name Dialing Yes This feature is available if users at the 
remote site are defined as remote users at 
the local site.

Personal Distribution Lists Yes Integrated AMIS Networking addresses can 
be included in a user’s PDL.
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Shared Distribution Lists Yes A remote user is required. A network 
address cannot be entered into the Shared 
Distribution List unless the address 
corresponds to a remote user.

Multiple Recipients No

Reply To No

Reply All No A message has only one recipient.

User’s Actual Personal 
Verification

Yes The user’s actual personal verification is not 
carried across sites.

Administrator-Recorded 
Personal Verification

No An administrator can record a personal 
verification for remote users who are 
defined at the local site.

Remote Site Spoken 
Names

Yes A spoken name can be recorded for each 
remote switch location during 
configuration.

Private Tag No AMIS does not support private message 
tags. For this reason, messages tagged as 
private are returned to the sender with a 
non-delivery notification.

Acknowledgment Tag Yes Acknowledgment tags indicate that the 
message was delivered to the remote 
system, not that it was listened to.

Urgent Tag Yes Users can tag a message as urgent, and the 
system treats it as urgent for prioritizing 
delivery. However, the recipient of an 
urgent message does not know it was tagged 
as urgent.

CallPilot feature Supported Notes
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Economy Tag Yes Users can tag a message as economy, and 
the system treats it as economy for 
prioritizing delivery. However, the recipient 
of an urgent message does not know it was 
tagged as economy.

Received Time Announced Yes The time when the message was deposited 
into the mailbox is announced to the 
recipient.

Sent Time Announced No

120-Minute  Messages No Message body length is limited to eight 
minutes. Messages longer than eight 
minutes are not sent, and a non-delivery 
notification is sent to the originator.

Sender’s Name (Text) Yes

Recipient’s Name (Text) Yes If the recipients are defined as remote users, 
their names are provided.

Message Subject (Text) No

Sender’s Department No

Timed Delivery Yes

CallPilot feature Supported Notes
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Implementing Integrated AMIS 
Networking

In this section
Overview 56

Implementation in a complex messaging network 60
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Overview

Introduction
Planning is critical to successfully implement Integrated AMIS Networking. 
Before you begin to implement Integrated AMIS Networking, you must 
understand the basic implementation process and know what information to 
provide.

The process for planning the implementation of a CallPilot networking solution 
is described in detail in the Networking Planning Guide. The following 
overview assumes that you are familiar with this description.

Before you begin
The following assumptions are made:

■ The switch is installed and configured.

■ Sufficient trunks that connect the switch to a public switch are available.

■ CallPilot is installed and configured, except for networking.

■ If it is part of the local site, Network Message Service (NMS) is fully 
implemented.

■ If implementation is an upgrade from Meridian Mail, all legacy information 
is available or is migrated.

■ Contact is made with the network administrators of the remote sites.

Fulfill all of these requirements before you continue with the implementation of 
Integrated AMIS Networking.
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Implementation steps
To implement Integrated AMIS Networking, you must complete the following 
steps:

■ Gather information for the network.

■ Configure the switch for Integrated AMIS Networking.

■ Configure CallPilot for Integrated AMIS Networking.

■ Configure CallPilot for AMIS Networking if this functionality is also 
required.

■ Add and configure the sites that use Integrated AMIS Networking to the 
local network database.

■ Test and back up the network.

Gather information for the network
The first step in implementing Integrated AMIS Networking is to gather the 
information required during the configuration. You must gather information 
about

■ the switch configuration

■ the remote sites

You must also create a network representation.

Gather information from the switch
Much of the information you need to implement Integrated AMIS Networking is 
available in the switch database.

For example, before you begin to implement networking, the switch is set up to 
make telephone calls to all the remote sites. The dialing plan exists in the switch 
database. You must reflect the dialing plan settings when you configure 
CallPilot for networking.

Ask the administrator who is responsible for the switch configuration to provide 
this dialing plan information.
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Create the messaging network representation
You need information about the other sites in the messaging network to create a 
messaging network representation.

You must create a detailed representation. This representation, which is your 
blueprint for implementation, shows the relationship between all sites.

Configure the switch
The switch must be set up and configured at your site before you begin to 
implement Integrated AMIS Networking. However, you must check the 
configuration and ensure that it is properly configured for Integrated AMIS 
Networking.

The only additional switch configuration necessary for Integrated AMIS 
Networking is the creation and setting of phantom DNs.

Configure CallPilot
The network database contains information about your messaging network. 
When you configure CallPilot, you add information to the network database. 
You must add the following information to configure CallPilot:

■ general information about the message delivery configuration

■ detailed information about the local site: information about how the server 
handles messages and how the switch handles messages

■ detailed information about each remote site that communicates with the 
local site using Integrated AMIS Networking

Validate the configuration
When you implement Integrated AMIS Networking, you add configuration 
information about the messaging servers and switch locations to your network 
database.

Before you add this information, CallPilot validates the information to ensure 
that there are no conflicts.
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Keep records
As you plan and implement Integrated AMIS Networking, it is important to keep 
detailed records about your site.

These records

■ Provide a source of information for support personnel.

■ Share information about the site with other network administrators.

Test the network
When you complete the configuration of Integrated AMIS Networking, you 
perform a test suite. This test suite ensures that the configuration is correct and 
that Integrated AMIS Networking is working properly.

Back up the network
When you successfully complete the test suite, you perform a backup. The 
backup ensures that no configuration information is lost in the event of system 
failure.

See also
If you need additional information about the general implementation process, 
consult the Networking Planning Guide.

The Networking Planning Guide provides a more detailed discussion about the 
preliminary requirements, how to create network diagrams, and how to maintain 
a network history.
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Implementation in a complex messaging 
network

Introduction
Integrated AMIS Networking is usually part of a complex messaging network 
that combines several CallPilot networking solutions.

Order of implementation
If you are implementing any other CallPilot networking solutions on your site, 
you will make the process easier to understand and manage by following the 
correct order of implementation.

The implementation of each networking solution builds upon earlier 
implementations. Information is often configured only once, and all subsequent 
networking solutions that are implemented use this configuration.

Recommended order
The recommended order for implementation is

■ Network Message Service (NMS)—if the local site is an NMS site

■ Integrated AMIS Networking

■ Enterprise Networking

■ VPIM Networking

AMIS Networking
If your local site exchanges messages with both integrated and open sites, 
implement Integrated AMIS Networking only. Integrated AMIS Networking 
also contains the functionality of AMIS Networking.

Implement AMIS Networking by following the procedures in the AMIS 
Networking Implementation and Administration Guide only if your local site 
exchanges messages with open sites exclusively.
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How Integrated AMIS Networking works

In this section
About Integrated AMIS Networking messages 62

About Integrated AMIS Networking parameters 64

About AMIS Networking parameters 68

Understanding Integrated AMIS Networking settings 71
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About Integrated AMIS Networking messages

Introduction
You use Integrated AMIS Networking to exchange messages with sites in a 
messaging network. When you implement Integrated AMIS Networking, you 
configure the system to handle these messages in a particular way.

An understanding of the basic components of a message makes the 
implementation process and configuration of CallPilot easier to understand.

Integrated AMIS Networking message
Every Integrated AMIS Networking message contains two parts:

■ a message header

■ the recorded message

Message header
The message header transmits to the receiving site with  DTMF signals. The 
header contains the following information:

■ the sender’s address (which includes the system access number and the 
mailbox number)

■ the recipient’s address (mailbox number)

■ the system access number

■ the type of message (regular, acknowledgment, or non-delivery notification 
[NDN])

■ the priority applied to the message (private, urgent, or acknowledgment)

Message body
The recorded message and spoken name are played over the voice port of the 
sending site and are recorded by the receiving site. The recorded message 
contains the following information:

■ the voice portion of the message

■ any attachments
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Message priorities
The sender can assign a message priority to an Integrated AMIS Networking 
message. There are three priorities:

■ economy

■ standard

■ urgent

One message priority, usually standard, is the default. Users must assign another 
message priority manually.

Configuration required for each message priority
The message priority tag that is assigned to a message determines how CallPilot 
handles the message.

When you implement Integrated AMIS Networking, you configure the 
scheduling parameters that determine how messages with different message 
priority tags are handled.

In general, you send economy messages during lower long-distance toll charge 
periods. You send urgent messages quickly, with the emphasis on speed rather 
than cost.
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About Integrated AMIS Networking 
parameters

Introduction
You set Integrated AMIS Networking parameters during the implementation 
process. These parameters work with internal CallPilot settings to control how 
Integrated AMIS Networking works.

Before you begin the implementation process, you must understand these 
parameters and decide on their settings.

Parameters set during implementation
CallPilot uses scheduling parameters to determine when to send messages to 
remote sites. CallPilot uses the following scheduling parameters:

■ batch threshold

■ stale times

■ economy message priority delivery start and stop times 

Parameter default values
CallPilot provides default settings for all scheduling parameters. The default 
values are based on typical requirements.

To ensure a quick implementation process, use these default values.

After your system is operational, monitor usage to determine if the default 
settings are serving the needs of your users. You can modify the scheduling 
parameters whenever users’ needs change.

For all default values, see “Defaults” on page 124.
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Batch threshold
The batch threshold is the number of standard and urgent messages that are held 
in queue waiting for delivery to a single remote site. When you send messages in 
batches, you make more efficient use of system resources. However, to ensure 
that messages awaiting delivery are not held too long in the queue, the holding 
time overrides the batch threshold. A message is held in a batch until either the 
batch threshold is exceeded or the holding time for standard or urgent messages 
is reached.

Batch thresholds apply only to standard and urgent messages.

Holding time
Holding time is the period of time that a message is held in queue before 
CallPilot attempts delivery. CallPilot holds a message in queue while it awaits 
the arrival of more messages for the same destination. This bulk sending makes 
more efficient use of the system.

However, to ensure that messages are always delivered in a timely fashion and 
do not wait too long for the arrival of additional messages, they are held for only 
a set period of time. This is the holding time.

CallPilot computes the holding time internally, based on the stale time.

Standard message holding time
The holding time for standard messages is one-third of the stale time for 
standard messages.

Urgent message holding time
The holding time for urgent messages is one-tenth of the stale time for urgent 
messages.
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Stale time
Stale time determines how long an undeliverable message is held within the 
system before being returned to the sender with a non-delivery notification 
(NDN).

You set stale times independently for economy, standard, and urgent messages. 
Typically, the stale time for a standard message is longer than the stale time for 
an urgent message, because it may be critical for a user to know that an urgent 
message was not delivered.

The following examples are based upon an Integrated AMIS Networking site 
that uses the default values.

Example 1
Milo Feinstein sends a standard message. The message is held in the queue 
awaiting the arrival of three more messages. However, when the message has 
waited in queue for 40 minutes (the holding time for standard messages), the 
message is sent.

Example 2
Ronnie Prakesh and Philippe Dumont are users at the same site. Ronnie sends 
three standard messages for users at the remote site in Newmarket. Her 
messages are held in the queue. Philippe sends a message to a user at the same 
remote site. The batch threshold is reached, and all four messages are sent.

Example 3
Barney Gumbolski sends an urgent message. It is held in queue. No other 
messages for the same remote site arrive within six minutes (the holding time for 
urgent messages). Barney’s urgent message is sent.
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Economy delivery start and stop times
Economy messages are handled differently from standard and urgent messages. 
Economy messages are collected and are sent only during designated times, 
rather than held in queues.

The delivery start and stop times determine when the system sends economy 
messages to their destinations.

Economy messages usually have a start time that corresponds to the beginning 
of lower-rate telephone charges, and a stop time set to the resumption of regular 
rates.

Example
The following example is based on an Integrated AMIS Networking site that 
uses the current default values.

At 8:00 a.m., Marge Sampson sends an economy message to a remote site. The 
message is held in queue until the economy delivery start time. The message is 
held in queue for a total of 16 hours. The economy message stale time is large 
enough to take this into account.
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About AMIS Networking parameters

Introduction
The functionality of AMIS Networking is inherent within Integrated AMIS 
Networking. When you implement Integrated AMIS Networking, you decide if 
the local site can use this functionality, which enables users to exchange 
messages with open sites.

If your local site uses the AMIS Networking functionality, you must also 
configure the Open AMIS parameters that determine how messages to open sites 
are handled.

Why these parameters are important
The Open AMIS parameters are important because they determine how 
CallPilot sends AMIS messages to open sites.

Since Open AMIS messages can incur long-distance toll charges, it is especially 
important that you consider how these parameters are set.

Open AMIS parameters
The parameters that apply to Open AMIS messages are

■ economy message stale time

■ Open AMIS compose prefix

■ economy delivery start and stop times

■ Open AMIS delivery times

Economy message stale time
The economy message stale time for Open AMIS messages functions in the 
same way as the economy message stale time for Integrated AMIS messages.
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Open AMIS compose prefix
The Open AMIS compose prefix is a number that alerts CallPilot that the rest of 
the number to be entered is an AMIS address.

The AMIS compose prefix must not conflict with any other prefixes used in the 
system, such as the name dialing prefix or the VPIM prefix.

Example
A local user logs in to CallPilot and enters 75 to compose a message. The user 
enters the Open AMIS compose prefix (in this example, 13). The system is 
alerted that this message is being addressed to an open site. The user enters the 
system access number and the mailbox number to complete the address.

Economy delivery start and stop times
The economy delivery start and stop times for Open AMIS messages are similar 
in concept to the times for integrated AMIS economy messages.

However, because Open AMIS messages may incur long-distance toll charges, 
you must set these carefully.

Open AMIS economy messages often have a delivery start time that corresponds 
to the start of lower long-distance toll charges and a stop time that corresponds 
to the resumption of regular rates.

Possible conflicts
The various scheduling parameters may conflict with each other. Therefore, 
when you set the Open AMIS delivery times, ensure that messages cannot 
become stale before they are delivered.
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Open AMIS delivery times
The Open AMIS delivery times determine the hours when Open AMIS 
messages are delivered during business days and nonbusiness days.

In some countries, these settings have legal ramifications. Open AMIS messages 
are directed to telephones automatically. If you address the message incorrectly, 
the unintended recipient may be disturbed at an inappropriate time. Therefore, 
computer-generated calls, such as Open AMIS messages, are legally allowed 
only during specific times of the business day.

If your country has these regulations in place, configure the Open AMIS 
delivery times to conform to the regulations.
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Understanding Integrated AMIS Networking 
settings

Introduction
Sites within the messaging network that use Integrated AMIS Networking to 
communicate use system access numbers (SANs) and networking connection 
DNs to initiate and establish sessions.

Relationship of a system access number to a connection DN
The following diagram shows the relationship of a system access number to a 
connection DN. 

A system access number becomes a connection DN in the network database 
record of a remote messaging server.
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How connection DNs work
The system access number uniquely identifies a site that uses Integrated AMIS 
Networking.

When you send a message to an integrated site, the local site looks up the 
connection DN for that remote site and initiates the network call. The local site 
identifies itself to the remote site by including its own system access number in 
the message header.

The receiving site takes that system access number and searches its own network 
database for a connection DN that matches the system access number.

If a match is found
The receiving site identifies the sending site if it finds a connection DN that 
matches the system access number it received. When the recipient listens to the 
message, the sending site is identified.

If a match is not found
If the receiving site does not find a connection DN that matches the system 
access number it received, it treats the message as an Open AMIS message sent 
from a remote site that is not part of the private messaging network. When the 
recipient listens to the message, the sending site is identified only as an open 
site.

Coordinated information
You must coordinate the information you need to exchange messages. A local 
site must gather information from every remote site with which it intends to 
exchange messages. You must give your local system access number to remote 
network administrators. These administrators enter your local system access 
number as a connection DN when they configure your site as a remote site in 
their network databases.
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How Integrated AMIS Networking handles 
messages

In this section
Overview 74

What the MTA does 76

What the ANA does 79

How a message is transferred 80
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Overview

Introduction
The scheduling parameters that you configure during the implementation of 
Integrated AMIS Networking work with internal CallPilot networking settings. 
These internal settings are controlled by the

■ Message Transfer Agent (MTA)

■ Analog Networking Agent (ANA)

This brief overview provides a general understanding of how Integrated AMIS 
Networking handles messages to help you interpret Alarm and Event reports.

MTA responsibilities
The MTA provides many of the basic maintenance functions required by 
CallPilot networking. The MTA is responsible for the following services:

■ Queue outgoing network messages.

■ Determine when to begin sending messages to a remote system.

■ Receive incoming messages for delivery to local users.

■ Collect networking traffic Operational Measurements (OM) reports.

To ensure the timely handling of messages, the MTA wakes up CallPilot every 
minute.

When it wakes up, the MTA does the following:

■ initiates calls to remote sites

■ checks for stale messages

■ checks if any sites are in error status
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MTA Monitor
The MTA Monitor continuously watches the performance of the MTA. The 
MTA Monitor provides detailed information and is useful for regular 
maintenance and troubleshooting. 

For complete information about the MTA Monitor and how it is used, consult the 
relevant section in the Support Tools Guide.

ANA responsibilities
The ANA send messages to and from remote systems.

There is one ANA for every active port used during an Integrated AMIS 
Networking session.

Main steps of message transfer
There are three main steps in the message transfer process:

■ The Message Transfer Agent determines if the message is ready for 
transfer.

■ The Analog Networking Agent completes a communication process, 
known as handshaking, with the receiving site.

■ The message, which consists of the message header and the message body, 
is transferred.
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What the MTA does

Introduction
The Message Transfer Agent (MTA) handles most aspects of message 
transmission for CallPilot.

How MTA and ANA handle messages
The following diagram is a graphical representation of how CallPilot handles 
Integrated AMIS Networking messages.
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The diagram shows the activity of both the MTA and the ANA in message 
handling.
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As the diagram indicates, the MTA handles most of the processing. Every 
minute, a scheduler wakes the MTA. The MTA scans the message queue for 
each destination, and checks the status of messages awaiting delivery. This scan 
determines if there are valid messages, according to the system parameter 
configuration. The MTA then determines if the valid messages are ready for 
delivery, according to the set system parameters.

Once the MTA determines that a transmission session is needed, it seeks a 
method of delivery from the call router. The ANA assumes responsibility for 
delivering the message.
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What the ANA does

Introduction
The Analog Networking Agent (ANA) works with the MTA to handle messages. 

How the ANA sets up calls
The ANA calls a remote site and delivers messages. 

CallPilot originates a network call to the receiving site using the connection 
directory number (DN) defined for that site. The switch places the call according 
to switch call-processing parameters.

If the call is successful, the call terminates on the networking connection DN at 
the receiving site.

If the call is not successful
If the call fails due to a busy or no-answer condition, CallPilot waits until the 
next wake-up interval before it attempts the call again. If three consecutive 
attempts fail, CallPilot places the receiving site into error status and an alarm is 
generated, depending on the nature of the problem.

CallPilot waits for one hour before it repeats the three-call attempt cycle.

When connection is established
When connection between the sending and receiving sites is established, ANA 
initiates a communication process known as handshaking.
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How a message is transferred

Introduction
After the ANA successfully establishes a message transfer session, the message 
transfer begins.

The message contains the message header and the recorded message.

Message transfer process
The following table describes how messages are transferred:

The sending site The receiving site

uses DTMF tones to send the message 
header to the integrated site. The message 
header contains:

■ the sender’s mailbox number without 
location prefixes

■ the sender’s system access number

■ the recipient’s mailbox without location 
prefixes

receives the DTMF tones, 
interprets the tones, and creates 
the message.

plays the voice portion of the message 
across a voice port.

records the message body and 
adds it to the message.

repeats these steps for each message the 
sending site must send.

Note: The maximum number of messages 
in a transfer session is five.

repeats these steps for each 
message.

terminates the message transfer session. hangs up.
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Coordinating with the system 
administrator

In this section
Overview 82
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Integrated AMIS Networking Implementation and Administration Guide 81



Getting started  Standard 1.0
Overview

Introduction
If the local site uses the AMIS Networking functionality that is inherent within 
Integrated AMIS Networking, and if you allow local users to send messages to 
open sites, you must establish user access.

You must carefully control user access, because long-distance toll charges may 
be incurred when messages are sent to open sites.

Levels of control
There are two basic levels of control:

■ When you define message delivery parameters, you define general system-
wide controls over AMIS Networking messages.

■ However, when you define different classes of users with basic 
administration, you define the access level individual users have to AMIS 
Networking.

Basic administration
Basic administration tasks include setting up the following:

■ users

■ mailboxes

■ mailbox classes

■ Restriction/Permission Lists (if messages are sent to open sites)

See also
For detailed information on each basic administration task, consult the Basic 
Administration Guide.
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Purpose of basic administration
With basic administration you can be more precise about how you want AMIS 
Networking to be used.

This precision is important because AMIS Networking can send messages 
outside of the private messaging network, which may result in long-distance toll 
charges. Therefore, controlling the access of users can result in considerable cost 
savings.

Example: Basic administration settings
You implement Integrated AMIS Networking and enable AMIS Networking as 
well. You configure your site to send and receive AMIS Networking messages. 
However, you restrict this ability to specific groups of users only.

Mailbox class settings
You control a user’s access to AMIS Networking, in part, by the mailbox class to 
which the user is assigned.

The following options for each mailbox class are available only if AMIS 
Networking is implemented:

■ default message priority—standard or economy

■ permission for exchange of messages with open sites

■ Restriction/Permission List for open messages, if you allow users to send 
messages to open sites

You must set the AMIS Networking options for each mailbox class.
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Getting there  Nortel SMI > Meridian Application Server > User Administration > 
Mailbox Classes > Call Handling tab

To set the default message priority

To set the default message priority as standard, select Standard.

To set the default message priority as economy, select Economy.
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To control the exchange of open networked messages

1 To enable this mailbox class to send messages to open sites, select the 
Compose/send check box.

2 To enable this mailbox class to receive messages from open sites, select 
the Receive check box.

3 If you have enabled this mailbox class to send messages to open sites, set 
the Restriction/Permission List.

For instructions on how to set a Restriction/Permission List, see “Assigning 
a Restriction/Permission List for AMIS Networking messages” on page 86.
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Assigning a Restriction/Permission List for 
AMIS Networking messages

Introduction
If you allow local users to exchange messages with open sites, create any 
necessary Restriction/Permission Lists for AMIS Networking. A Restriction/
Permission List defines any restrictions to access and also lists any exceptions to 
these restrictions.

Example
Local users can send messages to open sites. However, you want to ensure that 
different classes of users can send messages only to specific sites. Users with a 
manager-level mailbox class can send messages to any site. Users with a 
summer student mailbox class can send messages to any open site that does not 
incur long-distance toll charges.

Purpose
A Restriction/Permission List provides additional security and prevents 
unauthorized long-distance toll charges.

Creating a Restriction/Permission List
Usually, you will assign a pre-existing Restriction/Permission List. However, if 
no pre-existing list satisfies your requirements for AMIS protocol messages, you 
can create a new list.

See also
For detailed procedures on creating a Restriction/Permission List, consult the 
Basic Administration Guide.
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Gathering information

This chapter describes how to gather the information required to implement 
Integrated AMIS Networking. This chapter provides a checklist for all 
information that is needed about the switch configuration.

This chapter also describes how to gather information about the other sites in the 
messaging network, and how to convert this information into a messaging 
network representation.

In this chapter 
Information required 89
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Information required

In this section
Overview 90

Switch information 91

Information required from switch 93

Evaluating the switch information 96

Information from other sites 97

Messaging network representation 98
Integrated AMIS Networking Implementation and Administration Guide 89



Gathering information  Standard 1.0
Overview

Introduction
Before you can begin to implement Integrated AMIS Networking, gather the 
information you require. You will speed up the implementation process if you 
have this information before you begin. When you analyze the information and 
look for inconsistencies and incompleteness, you ensure that potential problems 
are resolved.

Required information
You must gather two types of information:

■ local site information, especially about the switch configuration 
information and dialing plan

■ messaging network information that is provided by all remote sites

Why gather information?
The gathered information is used to

■ Identify the sites in the messaging network.

■ Identify how the sites relate to each other.

■ Identify the dialing plan used by each switch in the network.

■ Determine if the dialing plan on one or more switches in the network must 
be modified to support the networking solutions of CallPilot.

■ Create a messaging network representation.

■ Prepare for CallPilot configuration.

Information about open sites
If local users exchange messages with open sites, gather the system access 
numbers of these open sites.

You also need the system access number of at least one open site that you can 
use when you test your implementation. Coordinate with the administrator of a 
remote open site before you begin to test the implementation.
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Switch information

Introduction
When you begin to implement Integrated AMIS Networking, the switch is 
already correctly installed and configured, and is operational for CallPilot.

This means that the switch is set up for dialing among the sites in the messaging 
network. The dialing plans that are configured on the switch for making 
telephone calls between sites are also used to exchange messages among sites.

You must check the configuration to make sure it is suitable for Integrated AMIS 
Networking.

Gathering dialing plan information
You need the dialing plan information that is configured on the switch. You must 
know the dialing plan used in the messaging network and how all sites dial one 
another.

The easiest way to gather this information is to ask the switch technician or 
system administrator.

Gathering information directly from the switch
Gathering information directly from the switch is not recommended. The 
information that you require is found on several switch configuration files called 
overlays. Finding the information can be difficult and time-consuming. 

If you must gather the information from the switch, consult your switch 
documentation for the proper procedures and detailed descriptions of the 
information in each overlay.
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Confirming settings
Usually, when the switch is configured, the switch technician addresses the 
impact of messaging on the switch.

However, to ensure that there will be no problems, you must confirm that the 
configuration suits the needs of Integrated AMIS Networking and can handle 
your anticipated volume of traffic.

If you discover that changes are necessary, you must complete these changes 
before you proceed with the implementation of Integrated AMIS Networking.
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Information required from switch

Introduction
You must gather information about the switch. You must verify that the switch 
supports networking. You use some of the information, such as dialing plan 
information, to configure CallPilot.

Gather information from

■ the local prime switch location

■ the remote switch locations (prime and satellite)

Note: If the local site is an NMS site, you must also gather information from 
each satellite switch location. For instructions on how to gather this information, 
consult the NMS Implementation and Administration Guide.

Gather information about used features only
Most of the information that you gather from the switch is related to the dialing 
plan.

Gather information about a dialing plan only if a dialing plan is being used. Do 
not gather the information if the dialing plan is installed on the switch but is not 
currently being used.

Example: Your switch has both ESN and CDP installed. However, only ESN is 
used. Do not gather CDP information.
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Local prime switch location information checklist
You need the following information from the switch configuration:

■ name or physical location of switch (useful to name the switch location on 
CallPilot)

■ dialing plan used

● Electronic Switched Network (ESN)

● Coordinated Dialing Plan (CDP)

● hybrid dialing plan, combining ESN and CDP

● another dialing plan, such as public switched telephone network

■ if ESN or hybrid dialing plan is used:

● ESN access code

● ESN location codes

- local switch location

- remote switch locations

● overlap of location codes with extension numbers

■ if CDP or hybrid dialing plan is used:

● CDP steering codes

- local switch location

- remote switch location

● overlap of steering codes with extension numbers

■ confirmation that sufficient trunks are available for anticipated networking 
traffic

■ confirmation that restrictions are suitable for networking (for example, 
trunk group access restrictions [TGAR])

■ range of extension numbers used at the local site (for example, 7000–7999)

■ information about existing CDNs and phantom DNs that are defined on the 
switch
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Remote switch location information checklist
For each remote site in the messaging network, you need the following 
information about each switch location (prime and satellite):

■ name or physical location of switch (useful to name the switch location on 
CallPilot)

■ dialing plan used

● Electronic Switched Network (ESN)

● Coordinated Dialing Plan (CDP)

● hybrid dialing plan, combining ESN and CDP

● another dialing plan, such as public switched telephone network

■ if ESN or hybrid dialing plan is used:

● ESN access code

● verify the ESN location codes

- local switch location

- remote switch locations

● overlap of location codes with extension numbers

■ if CDP or hybrid dialing plan is used:

● CDP steering codes

- local switch location

- remote switch location

● overlap of steering codes with extension numbers

■ range of extension numbers used at the local site (for example, 7000–7999)

■ confirmation that all extension numbers at this switch location can be 
dialed directly from the local switch

■ confirmation that all extension numbers at this switch location can be 
dialed in the same way
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Evaluating the switch information

Introduction
When you have the dialing plan information from all switches in the messaging 
network, review the information to ensure that you do not have to make any 
changes to switch configurations.

Mandatory requirement
The dialing plans of all switches in the network must have a uniform, or 
standardized, dialing plan.

A uniform dialing plan means that users on all switches dial the same way to 
reach the same recipient. 

There is only one exception to this rule: ESN access codes can be different.

You need a uniform dialing plan to dial users on other switches within the 
messaging network and at public sites.

A uniform dialing plan offers the following benefits:

■ The network is easier to configure and maintain.

■ Future growth of the network is allowed.

Configuring dialing plan information
You need extensive switch programming experience to configure dialing plan 
information on a switch.

See also
You can find detailed information on dialing plan configuration in your switch 
documentation.

ATTENTION! If you determine that changes to the dialing plan 
configuration are necessary, ask a switch technician to 
confirm your conclusion and make the necessary 
changes.
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Information from other sites

Introduction
Implementation of a networking solution is a coordinated effort. Many decisions 
must be made before implementation begins.

Gather the following information before you begin to implement Integrated 
AMIS Networking:

■ site names

■ Enterprise site IDs, if Enterprise Networking is implemented in the 
messaging network

■ fully qualified domain names (FQDNs) of servers

■ the protocol used between the local site and all remote sites

■ the dialing plan used between the local site and all remote sites

■ connection DNs for each site that uses the AMIS protocol to exchange 
messages with the local site

If any remote sites are NMS sites, also gather the following information for each 
satellite switch location:

● switch location name

● switch type

● location ID
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Messaging network representation

Introduction
A messaging network representation provides a complete summary of your 
messaging network. This representation contains information about each of the 
sites and indicates the relationship between each pair of sites.

If sufficiently detailed, a messaging network representation is the primary source 
of information for implementing a messaging network.

The more detail you can supply, the easier you will find the implementation 
process.

A diagram is the most suitable form of representing most messaging networks. 
A spreadsheet is more appropriate for large messaging networks.

Definition: Messaging network diagram
A messaging network diagram is a graphical representation of your network. It 
includes the following types of information:

■ all sites in the network 

■ the protocols implemented at each site

■ the protocol used between sites

■ location codes and names

■ dialing plan information

Definition: Messaging network spreadsheet
A spreadsheet is more appropriate for representing a large messaging network. It 
provides the same information as the diagram.
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Benefits
There are many benefits to creating a representation of your messaging network. 
A representation

■ offers a clear view of how your network is connected

■ gathers all the required information in one source

■ provides a useful means of planning future modifications

■ helps during the analysis of traffic issues

■ reveals areas for improvement

■ provides support personnel with a concise, clear view of your network

Coordinating efforts
Administrators of other sites must provide much of the information for your 
network representation. For example, you need to know the site name and other 
information of every site.

Although each site administrator creates a representation, ideally one site 
administrator should create a final version to distribute to all sites. This ensures 
that the representation is comprehensive and that each site uses the same 
information for implementation.

Protecting the representation
Your network representation contains sensitive information. Keep it properly 
stored and protected as part of standard security procedures.

See also
For detailed instructions on how to create a network representation, as well as 
for several examples, consult the relevant section in the Networking Planning 
Guide.
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Configuring the switch for Integrated 
AMIS Networking

This chapter describes how to configure the switch to implement Integrated 
AMIS Networking. This chapter introduces the concepts that are necessary to 
understand the configuration process and provides detailed configuration 
procedures.

In this chapter
Configuring the switch 103
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Configuring the switch

In this section
Overview 104

SDN Table and Integrated AMIS Networking 106

Adding and configuring SDNs 112

Phantom DNs and Integrated AMIS Networking 116
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Overview

Introduction
The switch provides the call handling for CallPilot.

When you implement Integrated AMIS Networking, the switch is already 
installed and configured, and is operational. It is ready for the implementation of 
Integrated AMIS Networking.

There are two steps in the configuration process. On the server, you must set up 
inbound and outbound service directory numbers (SDNs) for Integrated AMIS 
Networking. On the switch, you must set up phantom directory numbers (DNs).

Before you begin
Review the information that you gathered. Confirm the settings to ensure that 
they are correct.

Before you begin to implement Integrated AMIS Networking, complete and test 
any required changes to the switch settings.

How the switch views an Integrated AMIS Networking call
The switch handles an Integrated AMIS Networking message from the local site 
to a remote site like any other outbound telephone call.

The switch is already configured to handle outbound telephone calls.

Integrated AMIS Networking requirements
Like all services, however, Integrated AMIS Networking needs a route that 
connects the messaging server and the switch.

Integrated AMIS Networking requires only one additional configuration on the 
switch. A phantom DN is required.
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See also
For detailed information about the switch, consult your switch documentation.

For information about how CallPilot works with the switch and how the switch 
must be configured, consult the relevant section in the Advanced Administration 
Guide.
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SDN Table and Integrated AMIS Networking

Definition: SDN
A service directory number (SDN) is a number that enables a user to access a 
CallPilot service. Each SDN must be unique so that CallPilot can identify the 
requested service and play the appropriate prompts.

SDN Table
The system automatically creates the Service Directory Number Table during 
the initial installation of CallPilot. The SDN Table lists all SDNs and provides 
details about their settings.

CallPilot uses the SDN Table to map directory numbers (DNs) to services. The 
SDN Table lists both inbound and outbound SDNs.

Inbound and outbound SDNs
CallPilot requires both inbound and outbound SDNs. 

You must manually add an inbound SDN. An outbound SDN is created 
automatically if Integrated AMIS Networking is installed. Both the inbound and 
the outbound SDNs require additional configuration.

Inbound SDNs
For most services, an inbound SDN is a number that a user enters to access a 
service. However, the Integrated AMIS Networking inbound SDN is not a 
directly dialable number. A remote system dials this SDN when it delivers an 
Integrated AMIS Networking message.

Outbound SDNs
CallPilot uses an outbound SDN to make the requested service available. An 
outbound SDN consists of the word OUTBOUND and a number.
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Example: SDN Table
The following illustration shows an SDN Table that lists both inbound and 
outbound Integrated AMIS Networking SDNs. 

If another service shares the inbound Integrated Networking SDN, that service 
appears in the SDN Table. 

When you review an SDN Table, the only way you know if an SDN is shared is 
by the description. For this reason, the description of the SDN should mention 
that it is shared with the inbound Integrated AMIS Networking SDN.

SDN numbers
An SDN must be unique, but it is not randomly selected. CallPilot uses SDNs to 
map numbers to services. There are also important relationships between the 
SDN and other numbers used by the system.

Relationship of SDN to other numbers
The CallPilot SDN setup echoes the DN settings on the switch.

An important relationship exists between the inbound SDN and the local system 
access number (SAN), and the phantom DN on the switch. For example,
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■ The inbound Integrated AMIS Networking SDN = 7400.

■ The phantom DN for Integrated AMIS Networking = 7400.

■ The Integrated AMIS Networking local SAN =
1-416-597-7400.

The Integrated AMIS inbound SDN on CallPilot must correspond to the 
Integrated AMIS phantom DN on the switch. Before you create an SDN for 
Integrated AMIS Networking, confirm the phantom DN on the switch.

To view the phantom DN setting, consult the gathered switch information.

Phantom DNs
There are two ways to create an Integrated AMIS Networking phantom DN on 
the switch:

■ Define a new phantom DN for Integrated AMIS Networking.

■ Share an existing phantom DN of specific services.

Media type
To process a call, Integrated AMIS Networking needs access to a channel. A 
channel provides a connection between the switch and the Digital Signal 
Processor (DSP) cards on the CallPilot server.

CallPilot supports three channel types. Each type corresponds to different 
media:

■ voice

■ fax

■ speech recognition

Integrated AMIS Networking can use all three channel types. However, a voice 
channel is recommended. By default, CallPilot automatically assigns a voice 
port to Integrated AMIS Networking.
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Minimum and maximum channels
You must determine the channel resources for both inbound and outbound 
Integrated AMIS Networking SDNs.

Every service, including Integrated AMIS Networking, requires channel 
resources to process calls. Channel resources are the number of channels that 
Integrated AMIS Networking has available. Channel resources are set as 
minimum and maximum values. The minimum value is the number of channels 
that is always reserved for the exclusive use of the service.

This setting is important because, if you incorrectly allocate channel resources, 
users may experience delays in reaching requested services.

Example: Channel allocation
Your system has 96 available channels. You decide to dedicate a minimum of 5 
channels and a maximum of 30 channels to Integrated AMIS Networking. If the 
system handles only 5 Integrated AMIS Networking calls each day, a more 
appropriate allocation is a minimum of 1 channel and maximum of 3 channels.

Examples: How to use inbound and outbound Integrated AMIS 
Networking SDNs

The following examples describe a network that consists of two sites, and show 
how to use the inbound and outbound Integrated AMIS Networking SDNs to 
provide services. 

In these examples, it is important to distinguish between messages sent by users 
and calls made by the CallPilot system itself.
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Example 1: Shared SDN
This example illustrates how to use a shared inbound SDN.

Howard wants to send a message to Joy in Chicago. He enters 6060, which is 
directed to the SDN for Integrated Voice/Fax. The request is directed to 
CallPilot, which routes it to the outbound Integrated AMIS Networking SDN. 
The system in Philadelphia calls the remote SAN of the system in Chicago, 
64447080, and the two systems complete the required handshaking before the 
message is transferred. 

The Voice Menu SDN, which is shared with the inbound Integrated AMIS 
Networking SDN, receives the message. The Voice Menu SDN is set to act when 
it receives an AMIS initiator tone. The message is directed to Joy’s mailbox.

G100994.eps

SDN Service

6060 Integrate Voice/Fax
6070 Announcement
6080 Inbound AMIS

Outbound AMIS 10

SDN Service
7070 Integrated Voice/Fax
7075 Express Messaging
7079 Fax on Demand
7080 Voice menu
        (acts on AMIS initiator tone)

Outbound Enterprise 10

MAS
Server

MAS
Server6444xxxx

6338xxxx

SAN = 64447080

SAN = 63386080

Joy Howard
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Example 2: Unique SDN
This example illustrates how to use an inbound Integrated AMIS Networking 
SDN that is not shared.

Joy wants to send a message to Howard in Philadelphia. She enters 7070, which 
is directed to the SDN for Integrated Voice/Fax. The request is directed to 
CallPilot, which routes it to the outbound Integrated AMIS Networking SDN. 
The system in Chicago calls the remote SAN of the system in Philadelphia, 
63386080, and the two systems complete the required handshaking before the 
message is transferred. The inbound Integrated AMIS Networking SDN receives 
the message and directs it to Howard’s mailbox.

See also
For detailed information on SDNs and SDN Tables, consult the relevant sections 
in the Advanced Administration Guide.

G100992.eps

SDN Service

6060 Integrate Voice/Fax
6070 Announcement
6080 Inbound AMIS

Outbound AMIS 10

SDN Service
7070 Integrated Voice/Fax
7075 Express Messaging
7079 Fax on Demand
7080 Voice menu
        (acts on AMIS initiator tone)

Outbound AMIS 10

Joy Howard

MAS
Server

MAS
Server6444xxxx

6338xxxx

SAN = 64447080

SAN = 63386080
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Adding and configuring SDNs

Integrated AMIS Networking SDNs
Integrated AMIS Networking requires an outbound SDN and an inbound SDN.

Outbound SDN
An outbound SDN is created automatically when you install Integrated AMIS 
Networking. You can modify the default channel resource allocation.

Inbound SDN
An inbound SDN is not created automatically. There are two ways to set up an 
inbound SDN:

■ Create a new inbound SDN.

■ Share an inbound SDN with certain other services.

The choice depends on your administrative requirements.

Services that can share an inbound SDN with Integrated AMIS 
Networking

Integrated AMIS Networking can share the inbound SDN of the following 
services:

■ Announcement Service

■ Enterprise Networking

■ Fax Information Service

■ Voice Menu

Do this If the primary concern is

Create new SDNs. Operational Measurement reports must be 
precise for each service.

Share SDNs with other 
services.

A shortage of DNs exists or is likely to exist.
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■ Time of Day Controller

■ Thru-Dial

Getting there  Nortel SMI > Meridian Application Server > System Configuration 
> Service Administration > Service Directory Number

To add and configure a new inbound SDN

1 From the SDN Table, select New from the File menu.

Result: The New Inbound Service Directory Number Properties dialog box 
appears.

2 On the General tab, enter the SDN number in the Service DN box.

Note: This number must correspond to a CDN or phantom DN on the 
switch.

3 Select an application from the Application Name list.

Result: The corresponding application ID appears in the Application ID 
box.

4 Select the type of channel required by the service in the Media Type list.
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5 If you want to reserve a minimum number of channels for the service, enter 
the number in the Minimum Channels box.

6 Do one of the following:

■ Select the Use Default Maximum box. This is the recommended option.

■ Enter the maximum number of channels that a service can use at one 
time in the Maximum Channels box.

Note: The maximum number of channels cannot exceed the total number 
of channels available on the server. If you enter a number larger than the 
total number of channels, a warning box appears asking you to change the 
number.

7 Enter any comments in the Comments box.

8 Click Save to add the SDN to the SDN Table.

To share an existing inbound SDN with Integrated AMIS Networking

1 Select an existing inbound SDN that can be shared with Integrated AMIS 
Networking from the SDN Table.

2 On the File menu, click New.

Result: The New Inbound Service Directory Number Properties dialog box 
appears.

3 On the General tab, in the Comments box, insert a brief comment that the 
SDN is shared with Integrated AMIS Networking. 

Tip: This comment appears in the final column of the SDN Table and is the 
easiest way to determine which SDN is shared with Integrated AMIS 
Networking.
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4 Click the Session Profile tab.

5 Select the Act on AMIS/Enterprise networking initiator tone box. 

Note: You select this option only for the SDN that is being shared with the 
inbound Integrated AMIS SDN.

6 Click Save to add the shared SDN to the SDN Table.
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Phantom DNs and Integrated AMIS 
Networking

Switch setting required for Integrated AMIS Networking
SDNs on the server have a direct correspondence to phantom directory numbers 
(DNs) on the switch.

If you create a new SDN for Integrated AMIS Networking, you need a phantom 
DN for Integrated AMIS Networking. If you share an existing SDN for 
Integrated AMIS Networking with an existing service, Integrated AMIS 
Networking also shares the phantom DN of that service.

Integrated AMIS Networking uses DNs
To access a CallPilot service, a user enters a unique dialable number. The 
dialable number is known as a directory number (DN). There are different types 
of DNs, including extension numbers and telephone numbers. 

The switch uses the DN to route the call to the requested service.

Example 
A user enters a DN, 7505, to access Remote Notification.

Switch and DNs
All DNs that you use to access a service correspond to a setting on the switch. To 
handle calls in sequence of arrival, the system places calls in a queue, depending 
on the call type.

The switch has as many as three queues, called controlled directory number 
(CDN) queues, which you use for the following types of services:

■ Voice Messaging

■ Fax Call Answering

■ Speech Recognition Messaging

Each CDN queue is associated with a dialable number known as the CDN. A 
user can dial the service directly by entering the CDN.
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Example
The CDN of Voice Messaging is 7400. A user can dial 7400 to reach Voice 
Messaging. The call is placed into the queue.

Phantom DNs
While there are queues for three types of services, CallPilot users usually have 
many individual services available within each type. These services are also 
dialable.

To offer more than three services, the switch uses phantom DNs.

A phantom DN is a unique dialable number that is routed to one of the CDN 
queues.

A phantom DN is not a randomly selected number. There is a direct 
correspondence between the local system access number (SAN) for Integrated 
AMIS Networking and the phantom DN.

If Integrated AMIS Networking shares an existing phantom DN, check that the 
phantom DN is configured to forward messages to the correct CDN queue. For 
Integrated AMIS Networking, the phantom DN should forward messages to the 
Voice Messaging CDN queue.

Example
The phantom DN for Express Messaging is 7401. A user dials 7401 and expects 
to reach the requested service. However, the switch routes the phantom DN to 
the appropriate CDN queue (in this case, Voice Messaging) before the service is 
provided.

Integrated AMIS Networking phantom DN
Integrated AMIS Networking requires a phantom DN for incoming messages.

However, unlike other phantom DNs, it is not dialed by a local user when 
exchanging a message with an Integrated AMIS Networking site. The system 
uses this number when an Integrated AMIS Networking message must be sent to 
a remote site.

Users at remote sites also use the phantom DN when they make a call to a local 
system.
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Ways to create the phantom DN
There are two ways to create a phantom DN for Integrated AMIS Networking:

■ Use a unique phantom DN. Most switch technicians create additional 
phantom DNs for use by services like Integrated AMIS Networking.

■ Share an existing phantom DN. If Integrated AMIS Networking shares a 
service directory number (SDN) with another service, it also shares the 
phantom DN of the service.

See also
For a detailed description of how the switch is configured for CallPilot, consult 
the Advanced Administration Guide.
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Configuring CallPilot for Integrated 
AMIS Networking

This chapter describes how to configure CallPilot to implement Integrated 
AMIS Networking.

The chapter introduces the concepts that are necessary to understand the 
configuration process and provides detailed descriptions of configuration 
procedures.

In this chapter 
About configuring CallPilot 121
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About configuring CallPilot

In this section
Overview 122

Configuration summary 123

Message delivery parameters—AMIS 1 tab 126

Message delivery parameters—AMIS 2 tab 131

Configuring the message delivery parameters 135

Enabling AMIS Networking functionality 137

Creating a loopback mailbox 140
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Overview

Configuring CallPilot
The implementation of Integrated AMIS Networking requires additional 
configuration of CallPilot. This configuration determines how Integrated AMIS 
Networking exchanges messages with other sites in the messaging network.

To configure CallPilot for Integrated AMIS Networking, you must

■ Confirm CallPilot administration settings.

■ Define Integrated AMIS Networking information.

■ Create a loopback mailbox.

Before you begin
Complete the switch configuration before you configure CallPilot.

If your Integrated AMIS Networking site is an NMS network, NMS should be 
configured and tested.

ATTENTION! You must perform each step in the configuration process 
in the order presented.
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Configuration summary

Introduction
The Integrated AMIS Networking message delivery configuration determines 
how Integrated AMIS Networking handles messages.

You provide this information on two tabs of the Message Delivery Configuration 
dialog box:

■ AMIS 1

■ AMIS 2

Required information
When you complete the AMIS 1 and AMIS 2 tabs, the following are required:

■ enabled outgoing and incoming Integrated AMIS Networking

■ defined local AMIS system access number

■ batch threshold

■ economy delivery times

■ stale times

See also
For a general overview of how Integrated AMIS Networking uses this 
information, see the section “How Integrated AMIS Networking works” on page 
61.

Open AMIS boxes
As you configure the Integrated AMIS Networking message delivery 
information, you will see several boxes for configuring Open AMIS.

If users at the local site exchange messages with open sites, you must also 
configure the Open AMIS boxes.
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Defaults
CallPilot provides default settings for the message delivery configuration. The 
default values are based on typical requirements.

To simplify the process of implementing Integrated AMIS Networking, use the 
default values. After your system is operational, monitor usage and performance 
to determine if the default settings are sufficient. You can modify the settings 
whenever users’ needs change.

Parameter Current default

Batch threshold 4 messages

Stale time for standard messages 2 hours

Holding time for standard messages 40 minutes (calculated internally, 
based on stale time settings)

Stale time for urgent messages 60 minutes

Holding time for urgent messages 6 minutes (calculated internally, 
based on stale time settings)

Stale time for economy messages 6 hours

Delivery start time for economy 
messages

6:00 p.m.

Delivery stop time for economy 
messages

11:00 p.m.
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Suggested process
You should read through this section on configuring Integrated AMIS 
Networking information. The settings that you select determine how efficiently 
your system handles Integrated AMIS Networking messages.

Ideally, know how you are going to complete the required information before 
you begin the configuration.

Before you begin
You must properly configure the inbound and outbound SDNs for Integrated 
AMIS Networking before you configure Integrated AMIS Networking.
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Message delivery parameters—AMIS 1 tab

Introduction
To implement Integrated AMIS Networking you must set the parameters that 
CallPilot uses to deliver messages.

These parameters are set on the Message Delivery Configuration AMIS 1 and 
AMIS 2 tabs.
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AMIS 1 tab
The following shows the Message Delivery Configuration—AMIS 1 tab.
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Outgoing and incoming AMIS
If Integrated AMIS Networking is installed on your system, the following 
options are enabled by default:

■ Outgoing AMIS Networking

■ Incoming AMIS Networking

These boxes restrict the use of Integrated AMIS Networking. They also restrict 
the use of AMIS Networking.

If you do not want local users to send outbound Integrated AMIS Networking 
messages, clear the Outgoing AMIS Networking option.

If you do not want local users to receive inbound Integrated AMIS Networking 
messages, clear the Incoming AMIS Networking option.

To completely disable Integrated AMIS Networking, clear both options.

Local AMIS system access number
CallPilot requires a system access number (SAN) to initiate and establish 
network calls.

The system access number uniquely identifies an Integrated AMIS Networking 
site in a messaging network.

There are two types of system access number:

■ public network

■ private network

Public network local AMIS system access number
If your site has a public network system access number, your site can be reached 
from the public telephone switch network and the private messaging network.

The use of a public network system access number allows more systems to 
connect to your site.
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Private network local AMIS system access number
If your site has a private network system access number, your site can be reached 
only from the private messaging network.

Use a private network system access number if your messaging network is not 
connected to, or plans to connect to, systems over the public telephone switched 
network.

The use of a private network system access number is uncommon.

Batch threshold
When you batch messages, you send messages that are intended for a single 
destination in a group. This method makes more efficient use of the system than 
if you send each message separately.

The batch threshold defines the maximum number of messages intended for a 
single destination that can be queued before CallPilot begins to send the 
messages.

The batch threshold applies only to standard and urgent message types.

The batch threshold overrides the CallPilot holding times.

Stale times
Stale time is the period of time that CallPilot holds an undelivered message 
before it considers the message undeliverable and returns it to the sender with a 
non-delivery notification (NDN). In the period before a message is considered 
stale, CallPilot makes repeated attempts at delivery.

Stale time is expressed as a time period, such as 10 minutes or 5 hours.

Separate stale times are set for economy, standard, and urgent messages. The 
stale time for urgent messages should be the shortest time, because it is critical 
to know if an urgent message is not delivered.

Set a stale time for economy Open AMIS messages if local users send AMIS 
Networking messages to open sites.
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Stale time settings affect holding times
CallPilot uses stale time settings to calculate holding times. 

The holding time is the period of time that a message is held in queue before an 
attempt is made to send it.

Urgent messages
For urgent messages, the holding time is one-third of the stale time.

For example, if you set the urgent stale time to 30 minutes, the urgent message 
holding time is automatically set to 10 minutes. 

Standard messages
For standard messages, the holding time is one-tenth of the stale time.

For example, if you set the standard stale time to 5 hours, the standard message 
holding time is automatically set to 30 minutes.

Holding times interact with the batch threshold
The interaction of the holding time and the batch threshold ensures that 
messages are delivered in a timely and efficient manner. A message is sent when 
the batch threshold is reached or when the holding time is reached, whichever is 
sooner.
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Message delivery parameters—AMIS 2 tab

Introduction
You complete the configuration of the Integrated AMIS Networking delivery 
parameters on the AMIS 2 tab.

Complete this tab for Integrated AMIS Networking. Complete all Open AMIS 
fields to enable the functionality of AMIS Networking.
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AMIS 2 tab
The following shows the Message Delivery Configuration—AMIS 2 tab.
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Open AMIS compose prefix
If users are exchanging messages with open sites, provide the Open AMIS 
compose prefix. This number alerts the system that the number about to be 
entered is an Open AMIS address.

The Open AMIS compose prefix must not conflict with any other prefixes used 
in the system, such as the name dialing prefix or the VPIM prefix.

Economy delivery start and stop times
An economy message is a message that a user tags for economy delivery.

Economy messages are treated differently from standard and urgent messages. 
Economy messages are collected through the day and sent only during 
designated times, rather than held in queues. The delivery start and stop times 
determine when the system sends economy messages to their destinations.

Economy messages often have a start time set to the beginning of lower-rate 
telephone services, and a stop time set to the resumption of regular rates.

Set two delivery times for economy messages:

■ start time

■ stop time

Example
If the telephone rate is lower between 11:00 p.m. and 6:00 a.m., set the start time 
at 11:00 p.m. and the stop time at 5:55 a.m.
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Open AMIS delivery times
If local users send AMIS Networking messages to sites that are not part of the 
messaging network, you must define the Open AMIS delivery times.

Open AMIS delivery times determine how AMIS Networking messages are 
handled during business and nonbusiness days. In some countries, these settings 
have legal ramifications.

Open AMIS Networking messages are considered computer-generated calls. 
Since they are sent to recipients who are not part of the private messaging 
network, there is a risk of disturbing the wrong recipient.

For this reason, many countries legally allow computer-generated calls only 
during set times of the business day.

If your country has these regulations in place, configure the Open AMIS 
delivery times.

If your country does not have these regulations, or if your local site does not 
send AMIS Networking messages to sites that are not part of the messaging 
network, do not configure the Open AMIS delivery times.
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Configuring the message delivery parameters

Introduction
You must configure the parameters that determine how your system handles 
messages.

You configure these parameters on the Message Delivery Configuration AMIS 1 
and AMIS 2 tabs.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 tab

To configure Integrated AMIS Networking parameters

1 To enable your site to send outgoing Integrated AMIS Networking 
messages, ensure that the Outgoing Integrated AMIS Networking check 
box is selected.

2 To enable your site to receive incoming Integrated AMIS Networking 
messages, ensure that the Incoming Integrated AMIS Networking check 
box is selected.

3 Select the type of network used by the local AMIS system access number.

4 If you use a public network system access number, enter the country code, 
the area/city code, and the system access number.

If you use a private system access number, enter the number used to dial 
the local site.

5 Enter the batch threshold in the Collect (number of) messages before 
sending (Batch Threshold) box.

6 Enter the stale times for each message type:

■ Standard

■ Urgent

■ Economy Integrated AMIS

7 To continue the configuration, click the AMIS 2 tab.
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8 Enter the Integrated AMIS economy delivery start and start times in the 
Start Time and Stop Time boxes.

9 To enable AMIS Networking functionality, complete the Open AMIS boxes 
on the AMIS 1 and AMIS 2 tabs, as described in “Enabling AMIS 
Networking functionality” on page 137.

For Integrated AMIS Networking functionality only, click Save.

Result: The information is validated and saved to the network database.
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Enabling AMIS Networking functionality

Introduction
If your local site sends messages to open sites you must configure all Open 
AMIS boxes.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 tab

To configure AMIS Networking

1 On the AMIS 1 tab, enter the Open AMIS stale time.

2 On the AMIS 2 tab, enter the Open AMIS compose prefix for AMIS 
Networking capabilities.

3 Enter the economy delivery start and stop times.
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4 Click the Define Open AMIS delivery times button for AMIS Networking 
capability.

Result: The Delivery Times dialog box appears. 

5 In the Business Days column, select the days of the week that are normal 
business days for your organization.

6 In the Non Business Days column, select the days of the week that are 
considered nonbusiness days for your organization.

7 Enter the Business Days delivery start and stop times in the Delivery Time 
from: and to: boxes.

8 Enter the nonbusiness days delivery start and stop times in the Delivery 
Time from: and to: boxes.
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9 Click Save.

Result: The Delivery Times dialog box closes and you return to the AMIS 2 
tab. The information is validated and saved in the network database.

What’s next?
After you configure CallPilot for Integrated AMIS Networking, create a 
loopback mailbox. 

Every site in the messaging network requires a loopback mailbox that remote 
network administrators can use to test their systems. You will use the loopback 
mailboxes created by remote network administrators to complete your testing.

Although it is not mandatory, it is recommended that you create a loopback 
mailbox at this time.
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Creating a loopback mailbox

Introduction
When you implement Integrated AMIS Networking, create a loopback mailbox. 
Although it is not mandatory to create the loopback mailbox at this time, 
completing this task now will save you considerable time later.

Definition: Loopback mailbox
A loopback mailbox is a mailbox that is created at each site in a messaging 
network. You use a loopback mailbox to test the capability of a site.

To test that a site can send a message to a remote site, a message is sent to the 
loopback mailbox. The loopback mailbox automatically returns the message to 
the sender.

Remote sites use your loopback mailbox to test their systems. You use the 
loopback mailboxes of each remote site to test your system.

Since each site requires a loopback mailbox, create one now so that the testing 
can proceed without interruption.

Loopback mailbox requirements
A loopback mailbox is not a real mailbox because it does not collect messages. 
It bounces messages back to the sender. However, the loopback mailbox number 
must be unique and cannot conflict with any other mailbox number.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > Messaging 
Administration Properties > Mailboxes tab

To create a loopback mailbox

1 In the Networking Loopback mailbox box, enter the mailbox number.

2 Click Save.

Result: The information is validated and saved to the database.

Announce the loopback mailbox
Remote network administrators test their implementation by sending an 
Integrated AMIS Networking message to your loopback mailbox. Announce the 
loopback mailbox number to all remote sites.

Similarly, gather the loopback mailbox numbers from the network 
administrators of all other remote sites.

Using the loopback mailbox
A remote administrator addresses a test message to a loopback mailbox using 
the protocol and dialing plans specified for use between the two sites.

For example, you create a loopback mailbox, 9999, on Site 6. Integrated AMIS 
Networking is used between Site 4 and Site 6. The ESN dialing plan is used, and 
the ESN prefix to address Site 6 from Site 4 is 3555. Therefore, to address your 
loopback mailbox, the network administrator at Site 4 enters 35559999.

See also
For more information on creating mailboxes and assigning them a class of 
service, consult the Advanced Administration Guide.
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c h a p t e r  6

Adding sites to Integrated AMIS 
Networking

This chapter describes how to define the sites in the messaging network that 
exchange messages with the local site using Integrated AMIS Networking.

This chapter describes how to configure the local messaging server and prime 
switch location. It also explains how to add and configure remote messaging 
servers and switch locations.

In this chapter 
About the messaging network 145

Configuring the local site 151

Adding and configuring a remote site 173
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About the messaging network

In this section
Overview 146

Configuration and other networking solutions 147
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Overview

Introduction
A CallPilot messaging network consists of a local site and one or more remote 
sites.

All sites in your private messaging network with which your local site 
exchanges messages must appear in the Messaging Network Configuration tree 
view. If a remote site is part of the messaging network, but the local site does not 
exchange messages with that remote site using Integrated AMIS Networking, 
you do not add it to the tree view during the implementation of VPIM 
Networking.

To implement Integrated AMIS Networking, configure the local site and add and 
configure all remote sites that will transfer messages with the local site using 
Integrated AMIS Networking.

See also
Sites are configured in the Messaging Network Configuration tree view. For an 
overview of how to work with the tree view, consult the relevant section in the 
Networking Planning Guide.

Before you begin
You should have already configured the Message Delivery Configuration dialog 
box for Integrated AMIS Networking.

If your local site is an NMS site, NMS should be configured and tested.

Your messaging network representation should be complete and available. This 
representation provides a blueprint for the implementation process.

ATTENTION! It is strongly recommended that you complete each step 
in the configuration process in the order presented.
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Configuration and other networking solutions

Introduction
If any other CallPilot networking solution is installed on your local system, 
much of the local messaging server and the local switch configuration work is 
already complete.

Configuring the local messaging server and switch location
If another networking solution is installed on the local site, the local messaging 
server and prime switch location configuration is almost entirely complete. You 
must only confirm the settings and enter the information that is specifically 
required to implement Integrated AMIS Networking.

NMS local site
If your local site is an NMS site, implement and test NMS before you begin to 
implement Integrated AMIS Networking.

If NMS is installed, the NMS satellite switch locations for the local site appear 
in the Messaging Network Configuration tree view below the local prime switch 
location.

Remote sites
If another CallPilot networking solution is implemented on your system, remote 
sites may already be added and configured. These sites appear in the Messaging 
Network Configuration tree view. These sites communicate with the local site 
using the other networking solution.

When you implement Integrated AMIS Networking, you must add and 
configure the remote sites that will communicate with your local site using 
Integrated AMIS Networking. These sites appear in the tree view only as you 
add them.
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Example: Implementing Integrated AMIS Networking
In this example, you are the network administrator of Site 6. Working with the 
network administrators of the other sites, you have created a diagram of your 
messaging network. Note that many details are removed from this network 
diagram for clarity. 

Your local site has the following networking solutions: Integrated AMIS 
Networking, AMIS Networking (available because Integrated AMIS 
Networking is implemented), NMS, and Enterprise Networking.

Since you are following the recommended order of implementation, you have 
implemented and tested NMS.

To implement Integrated AMIS Networking, you add the following remote sites 
to your network database because you use the AMIS protocol to exchange 
messages with them:

■ Site 3

■ Site 4

■ Site 5—satellite switches are also added

Your site is set up to exchange messages with an open site that is not part of your 
messaging network. When you set the Integrated AMIS Networking message 
delivery configuration parameters, you also complete all Open AMIS boxes.
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After you implement and test Integrated AMIS Networking, you implement 
Enterprise Networking. During this implementation, you add Site 1 and Site 2 to 
the Messaging Network Configuration tree view because you use the Enterprise 
Networking protocol to exchange messages with these sites.
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Configuring the local site

In this section
Overview 152

Configuring the local messaging server 154

Configuring the local prime switch location 159

Configuring ESN information 165

Configuring CDP information 169
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Overview

Introduction
When CallPilot is initially installed on your system, a local messaging server 
and local switch location are automatically added to the Messaging Network 
Configuration tree view.

Local messaging server name
By default, both the local messaging server and the prime switch location are 
assigned the name “Untitled.” Assign new names to the local messaging server 
and the prime switch location during configuration.

The local site receives its name from the name assigned to the local messaging 
server.

Configuration
You must configure the local messaging server. To configure a messaging server, 
you save general information about the messaging server, such as name and 
description, to the network database.

The local messaging server is configured on the General tab of the Local Server 
Properties dialog box.

SMTP/VPIM Server FQDN
The SMTP/VPIM Networking Server FQDN box is enabled only if VPIM 
Networking is installed on your system. It is configured during the 
implementation of VPIM Networking.

However, if the box is enabled on the General tab, you must enter a placeholder 
in the box or you will be unable to close the tab and save the information to the 
network database.

While implementing Integrated AMIS Networking, enter a placeholder in this 
box. You will replace this placeholder with the correct server FQDN when you 
implement VPIM Networking.
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Configuring the local server if another messaging solution is 
implemented

If you have implemented another CallPilot networking solution on your local 
system, you have already completed the local messaging server configuration.

No additional configuration is required for Integrated AMIS Networking.
Integrated AMIS Networking Implementation and Administration Guide 153



Adding sites to Integrated AMIS Networking  Standard 1.0
Configuring the local messaging server

Introduction
You must configure the local messaging server to implement Integrated AMIS 
Networking.

If another networking solution is implemented, the configuration of the local 
messaging server is complete. You must only check the information.

The local messaging server is configured on the Local Server Properties—
General tab.
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Name
By default, both the local messaging server and the prime switch location are 
assigned the name “Untitled.” Assign new names during configuration.

The messaging server is usually given a name that corresponds to its geographic 
location.

Local site name
The name given to the local messaging server becomes the name of the local 
site.

Server type
The local messaging server is always CallPilot.

Description
Provide a brief description of the messaging server, or implementation notes, 
such as when the server was configured or who completed the configuration, in 
the Description box.

Send Messages to all other Servers
The Send Messages to all other Servers check box determines if the local site 
can send messages to integrated remote sites in the messaging network.

This check box is selected by default and is cleared only under exceptional 
circumstances.

When cleared, the local messaging server does not send messages to any 
integrated remote site using any protocol. Messages can still be sent to open 
remote sites.

When to clear this option
This option lets you quickly disable messaging from your local site. Clear this 
check box in emergency situations.
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Restricting messages to individual sites
Clearing the Send Messages to all other Servers check box is a quick way to 
disable the system.

You restrict the sending of messages to each remote site separately.

To prohibit the local messaging server from sending messages to a particular 
remote site, clear the Send Messages to this Server check box on the Remote 
Messaging Server Properties—General tab.

For example, your messaging network has six sites. You do not want to send 
messages to one of these sites. You select the Send Messages to all other Servers 
option while you configure the local messaging server. You clear the Send 
Messages to this Server box while you configure the remote server to which you 
do not want to send messages.

Note: When the Send Messages to all other Servers box is cleared, users can still 
send messages to open sites using the VPIM and AMIS protocols.

Add/Update Remote Users on this Server
The Names Across the Network feature is available with Enterprise Networking 
only.

The Add/Update Remote Users on this Server check box enables the Names 
Across the Network feature to work with Enterprise Networking.

If enabled, this check box was configured during the implementation of 
Enterprise Networking.

Enterprise Site ID
The Enterprise Site ID box is enabled only if Enterprise Networking is 
implemented on your local messaging server.

If the Enterprise Site ID box is enabled, the Local Messaging Server 
Properties—General tab cannot be closed, and the information cannot be saved 
to the network database unless the Enterprise Site ID box contains some 
information. 

If you do not know the Enterprise site ID, enter a valid placeholder and enter the 
correct ID when you implement Enterprise Networking.
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Receive Message Text Info
The Receive Message Text Info check box is enabled only if Enterprise 
Networking is installed on your local messaging server. Configure this box when 
you implement Enterprise Networking.

Server FQDN
The Server FQDN box is enabled only if VPIM Networking is installed on your 
local messaging server. The server FQDN is entered while you implement VPIM 
Networking.

However, the Local Server Properties—General tab cannot be closed and the 
information cannot be entered into the network database unless the Server 
FQDN box contains some information. 

If you know the server FQDN, enter it while you implement Integrated AMIS 
Networking. Otherwise, enter a placeholder that you can replace while you 
implement VPIM Networking.

For example, enter “FQDN_goes_here.” A clearly marked placeholder reminds 
you to replace the information when you implement VPIM Networking.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration

To configure the local messaging server

1 In the Messaging Network Configuration tree view, select the local 
messaging server.

2 On the File menu, click Open.

Result: The Local Server Properties—General tab appears.

3 To change the name of the local messaging server, enter a new name in 
the Name box.

Tip: The name given to the local messaging server is also the name of the 
local site.

Note: The server type is always CallPilot and cannot be changed.

4 In the Description box, enter details about the local messaging server.
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5 To send messages to all other sites in the messaging network, ensure that 
the Send Messages to all other Servers box is selected.

Note: The Add/Update Remote Users on this Server check box is enabled 
if Enterprise Networking is installed. Configure this setting when you 
implement Enterprise Networking.

6 If Enterprise Networking is installed, enter the Enterprise Site ID number for 
the local messaging server or a valid placeholder.

Note: The Receive Message Text Info check box is enabled only if 
Enterprise Networking is installed. Configure this setting when you 
implement Enterprise Networking.

7 If VPIM Networking is installed, the Server FQDN box is enabled. Enter the 
FQDN or a valid placeholder.

8 Click Save.

Result: The information is validated and saved to the network database.

What’s next?
After you configure the local messaging server, you must configure the local 
prime switch location.
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Configuring the local prime switch location

Introduction
You must configure the local prime switch location to implement Integrated 
AMIS Networking. 

The final step in configuring the local site for Integrated AMIS Networking is to 
configure the local prime switch location.

If any other networking solution is implemented
If another networking solution is implemented on the local site, the local prime 
switch location configuration is already configured.

You must check the current configuration information. Make any necessary 
modifications.

If NMS is implemented
If NMS is implemented on the local site, the information required for the local 
switch location configuration is already complete.

All satellite switch locations attached to the local prime switch location are also 
already installed.

If no other networking solution is implemented
If no other networking solution is implemented on the local site, you must 
complete the General tab. You may have to complete the ESN tab or the CDP 
tab, or both, depending on the dialing plan used on your local switch location.
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Where the prime switch location is configured
The local prime switch location is configured on the Prime Switch Location 
Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM

General tab
Complete the General tab no matter what dialing plan your site uses.

ESN tab
Complete the ESN tab if the local site uses the ESN or a hybrid dialing plan.
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CDP tab
Complete the CDP tab if the local site uses the CDP or a hybrid dialing plan.

SMTP/VPIM tab
The SMTP/VPIM tab is enabled only if VPIM Networking is installed on your 
local switch location.

You complete the SMTP/VPIM tab during the implementation of VPIM 
Networking.

General tab
The following explain all boxes on the General tab.

Name
Every switch location needs a name that is unique within the messaging 
network. Usually, this name is the same as the name of the messaging server. 
This ensures that the identity of the switch location within the network is 
immediately apparent. A geographic name is common.

For example, if a messaging server is named “Moscow,” the prime switch 
location is usually also named “Moscow.”

By default, the local prime switch location is given the name “Untitled.” This 
name must be changed.

Description
The Description box is useful for short notes, reminders, or comments about the 
switch location.

You might find it useful to specify your switch model, the date of the switch 
configuration, or contact information for the switch technician.

Enterprise Location ID
The Enterprise Location ID box is not enabled for the prime switch location.

Note: The location ID for the prime switch location is always 0 and cannot be 
changed.
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Spoken Name Recorded
If your local site is not an NMS site, the Spoken Name Recorded check box is 
not enabled.

If your site is an NMS site, the Spoken Name Recorded check box was 
configured during the NMS implementation.

Dialing plan information
You need detailed information about the dialing plan used by the local site when 
you configure the local prime switch location.

Dialing plans for dialing to this location
You must specify which of the following dialing plans is used to dial to the local 
switch location:

■ ESN

■ CDP

■ hybrid that combines ESN and CDP

■ another dialing plan (such as PSTN)

When you configure the local prime switch location, you specify the dialing plan 
that is used to dial to the local site.

Note: If you use ESN anywhere in the messaging network, you must select ESN 
because you need an ESN access code.

Mailbox specifications
The following boxes are dynamically enabled and disabled depending on the 
dialing plan you have specified for the local prime switch location:

■ Mailbox addressing follows dialing plan

■ Mailbox prefixes

Mailbox addressing follows dialing plan
The Mailbox addressing follows dialing plan check box is available only if NMS 
is installed on the local messaging server. If NMS is implemented, this check 
box should be properly configured already.
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Mailbox prefixes
A mailbox prefix is a leading string of digits that uniquely identifies a mailbox 
number as belonging to a particular site.

If the local site does not have NMS installed, the mailbox prefixes are never 
required for the local prime switch location.

If the local site does have NMS installed, the mailbox prefix, or prefixes, are 
already properly configured.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration

To configure the local prime switch location

1 In the Messaging Network Configuration tree view, select the local prime 
switch location.

2 On the File menu, click Open.

Result: The Messaging Network Configuration—Prime Location 
Properties—General tab appears.

. 

3 To change the name of the local prime switch location, enter a name in the 
Name box.

4 In the Description box, enter details about the local prime switch location.

Note: The Enterprise Location ID is always 0 and cannot be changed.

5 Confirm the status of the Spoken Name Recorded box.

Note: This box is enabled only if NMS is installed and was completed 
during the implementation of NMS.

6 Specify the dialing plan used to dial the local prime switch location. Select 
the

■ ESN check box if ESN is used

■ CDP check box if CDP is used

■ ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if another dialing plan, such as PSTN, 
is used.
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7 The Mailbox addressing follows dialing plan box and the Mailbox prefixes 
boxes are enabled only if NMS is implemented locally. If enabled, they are 
already configured.

8 Determine whether you must complete another tab. If not, click Save to 
close the dialog box. 

9 Select another tab to continue the configuration.

What’s next?

If the local site uses an ESN, CDP, or hybrid dialing plan
After you complete the General tab, you must complete the ESN tab, or the CDP 
tab, or both tabs, depending on the dialing plan used.

If the local site uses another dialing plan
If your local site uses another dialing plan, such as PSTN, you have completed 
the configuration of your local prime switch location.
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Configuring ESN information

Introduction
If the local prime switch location uses either an ESN dialing plan or a hybrid 
dialing plan, you must complete the ESN tab.

You must provide the ESN access codes and ESN location codes. These are 
combined to create the ESN prefix.

See also
For a description of the ESN dialing plan and how it works, consult the 
Networking Planning Guide.

. 
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ESN Access Code used by this location
The ESN access code is used to access ESN routing in the same way that an 
access code, such as 9, is used to dial out to the public network from a private 
network.

Typically, all switches in a messaging network use the same ESN access code.

ESN Location Codes
An ESN location code is a routing prefix that identifies a location within a 
network. It is usually three digits long, but can be up to ten digits long.

You must also indicate the number of digits in the ESN location code that 
overlap the mailbox number.

The ESN Location Codes list contains all ESN location codes currently assigned 
and indicates the overlap between the ESN location code and the mailbox 
directory numbers.

ESN location codes can be added, modified, or deleted at any time. The ESN 
location codes must always match the dialing plan configuration on the switch.

ESN location code capacity
The maximum number of ESN location codes for a switch location is 30.
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ESN location code overlap
When you are entering the dialing plan information for the local site, you must 
calculate the number of digits in the ESN prefix that overlap the digits in the 
local extension.

If there is overlap between the rightmost digit or digits of the location code and 
the leftmost digit or digits of the extension number, enter the amount of overlap.

The following table provides examples of ESN location code overlap.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Local Prime 
Switch Location Properties > ESN tab

Access 
code

Location 
code

Extension 
number

Number dialed by users at 
other sites Overlap

6 338 8300 63388300 0

6 338 8300 6338300 1

6 300 8000-8999 63008300-63008999 0

6 302 25000-26999 63025000-63026999 1
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To configure the ESN information

1 Enter the ESN access code.

2 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

3 In the Location Code box, enter the location code.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the location code.

5 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes list on the ESN tab.

6 Repeat steps 3–5 for each ESN location code required.

7 When you have finished configuring the ESN information, determine if you 
must configure CDP information. 

● If yes, click the CDP tab. 

● If no, click Save to validate the ESN information and save it to the 
database.

What’s next?
If your local prime switch location uses the hybrid dialing plan, click the CDP 
tab to continue configuring the local prime switch location.
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Configuring CDP information

Introduction
If the local switch location uses either a CDP dialing plan or a hybrid dialing 
plan, complete the CDP tab.

You must provide the CDP steering codes.

See also
For a general description of the CDP dialing plan and how it works, consult the 
Networking Planning Guide.
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CDP Steering Codes
A CDP steering code is a site prefix that identifies the local site within the 
network. Therefore, a CDP prefix must be unique for all switches in the 
messaging network.

CDP steering codes are determined by the switch technician. 

The CDP steering codes defined on the switch are entered on CallPilot because 
the system must be able to identify the steering code in the mailbox number to 
determine the site.

The CDP Steering Codes list box contains all CDP steering codes currently 
assigned to the switch location. The list box also indicates the overlap between 
the CDP steering codes and the mailbox directory numbers.

CDP steering codes can be added, modified, or deleted.

CDP steering code capacity
The maximum number of CDP steering codes for a switch location is 500.

CDP steering code overlap
When entering the dialing plan information, you must calculate the number of 
digits in the CDP steering code that overlap the digits of the local extension.

If there is overlap between the last digit or digits of the steering code and the first 
digit or digits of the extension number, enter the amount of overlap.

Normally, the steering code overlaps with the first few digits of a local extension 
number.

The following table provides three examples of CDP steering code overlap.

Steering 
code

Extension 
number

Number dialed by users at other 
sites

Amount of 
overlap

22 22345 2222345 0

22 22345 222345 1

22 22345 22345 2
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Local Prime 
Switch Location Properties > CDP tab

. 

To configure the CDP information

1 Click the Add New button.

Result: The New CDP Steering Code Properties dialog box appears.

2 In the Steering Code box, enter the steering code.

3 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the steering code.

4 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Code list box on the CDP tab.

5 Repeat steps 1–4 for each CDP steering code required.

6 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and saved to the network database.

What’s next?
You have completed the configuration of the local site and are ready to begin 
adding and configuring remote sites.
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Adding and configuring a remote site

In this section
Overview 174

Configuring a remote messaging server 175

Configuring a remote prime switch location 184

Configuring a remote satellite switch location 195

Recording a spoken name 199

Importing a spoken name 201

Non-CallPilot remote sites 203

Meridian Mail remote sites 205

Norstar Voice Mail remote sites 206
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Overview

Introduction
When you implement Integrated AMIS Networking, you add to the Messaging 
Network Configuration tree view all the remote sites that use Integrated AMIS 
Networking to exchange messages with the local site.

Every remote site added to the tree view must be configured.

Information required
The information that you enter when configuring a remote site reflects the 
information that is configured for that site in its own local network database. For 
example, you enter the name of that site and its FQDN. You must get this 
information from the remote network administrator.

But configuring a remote site is not simply copying the information provided by 
the remote site. You also enter information that reflects how your local site will 
communicate with that remote site. For example, for each remote site you decide 
whether your local site sends messages to this particular remote server.

Main steps
There are three main steps to adding a remote site to your local network 
database. For each remote site, you must add and configure

■ the remote messaging server

■ the remote prime switch location

■ the remote satellite switch locations, if the remote site is an NMS site

Network representation
Much of the information that you must provide while configuring a remote 
messaging server is contained in the network diagram or spreadsheet.
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Configuring a remote messaging server

Introduction
When CallPilot is initially installed on your system, your local site, consisting of 
a local messaging server and a local prime switch location, is automatically 
added into the Messaging Network Configuration tree view.

However, you must manually add each remote site that exchanges messages with 
the local site using Integrated AMIS Networking into the Messaging Network 
Configuration tree view. Both the remote messaging server and the remote prime 
switch location must be configured.

The following tabs must be completed for each remote messaging server:

■ Remote Messaging Server Properties—General tab

■ Remote Messaging Server Properties—Connection Information tab

Remote servers and other networking solutions
If you have implemented another CallPilot networking solution on your system, 
you have already added remote sites to the Messaging Network Configuration 
tree view.

The process of adding a remote site is essentially the same regardless of the 
networking solution being implemented. However, when you add remote sites 
during the implementation of Integrated AMIS Networking there are important 
differences to consider.
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Remote Messaging Server Properties—General tab
The Remote Messaging Server Properties—General tab contains detailed 
information about the remote messaging server and defines how the local site 
and the remote site exchange messages.

. 

Name
You should assign the remote messaging server the same name that was assigned 
to it by its local network administrator. This correspondence in naming sites 
makes the network easier to administer and maintain because all network 
administrators use the same names for the same sites.

For example, if a remote site calls itself Connecticut, you should name it 
Connecticut when you add it to the Messaging Network Configuration tree view.
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Server type
The remote messaging server can be any of the following types:

■ CallPilot (CallPilot)

■ Meridian Mail Net Gateway (MMNG)

■ Norstar Voice Mail (Norstar)

■ Meridian Mail

■ Other

Description
Provide a brief description of the remote messaging server or useful notes, such 
as when the messaging server was configured or who completed the 
configuration.

Send Messages to this Server
The Send Messages to this Server check box interacts with the Send Messages to 
all other Servers check box on the Local Messaging Server Properties—General 
tab.

When you configured the local messaging server, you decided if you wanted the 
local messaging server to send messages to all remote messaging servers. This 
option is selected by default and is cleared under exceptional circumstances 
only. 

However, you can still stop the delivery of messages to specific remote 
messaging servers. The Send Messages to this Server check box enables you to 
block the delivery of messages from your local messaging server to a particular 
remote site.
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Example: In the following diagram, Helsinki is configured to deliver messages 
to all other sites. However, the network database records for Paris and Cairo 
specify that messages are not sent to these remote sites. Messages are sent to 
Lammi and Korso-Rekola. Therefore, while the potential exists for sending 
messages to both remote sites, only two sites in the messaging network receive 
messages from Helsinki.

Send local user information to this Server
The Send local user information to this Server check box determines if the 
Names Across the Network feature is used with this remote site. If enabled, this 
feature was configured during the implementation of Enterprise Networking.
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Enterprise Site ID
The Enterprise Site ID box is enabled only if Enterprise Networking is installed 
on the local site. 

All remote sites connected to a site that has Enterprise Networking installed 
must have an Enterprise site ID, regardless of the actual protocol used with the 
site.

Therefore, if Enterprise Networking is installed locally, when implementing 
Integrated AMIS Networking, you must enter the site ID for all remote sites, 
even those that exchange messages with the local site using the AMIS protocol.

Consult the network representation for the correct Enterprise site IDs.

Send Message Text Info to this Server
This check box applies only to remote sites that use Enterprise Networking to 
exchange messages with the local site. For remote sites that use Integrated 
AMIS Networking, this box is not applicable.

Server FQDN
If VPIM Networking is installed on your local site, the VPIM Networking 
Server FQDN box is enabled.

However, since your local site transfers messages with this remote site using 
Integrated AMIS Networking, a Fully Qualified Domain Name (FQDN) of the 
remote server is not required.
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Remote Messaging Server—Connections tab
The configuration of a remote messaging server continues on the Connections 
tab.

Network protocol
When implementing Integrated AMIS Networking, you must specify that the 
protocol used by the local site to exchange messages with this remote site is 
AMIS.

To use a particular protocol, both sites must have the same networking solution 
installed and implemented.

If a remote site is not configured to use the same protocol as the local site, the 
following occurs when the local site attempts to send a message:

■ The message is not delivered.

■ An error message is generated.

■ The remote site is put into error status on the local system.
180 CallPilot



October 2003 Adding sites to Integrated AMIS Networking 
Integrated AMIS Networking connection DNs
When CallPilot initiates a call to a remote site, it uses the networking connection 
DN that is specified for the remote site in your network database.

You can define up to three DNs. DN1 is mandatory. DN2 and DN3 are optional.

At least one connection DN must be the Integrated AMIS Networking system 
access number for the remote site, as defined on the AMIS 1 tab of the Message 
Delivery Configuration Properties dialog box of the remote site.

You should include the system access number of the remote site on the network 
representation. If you do not have the system access number, contact the 
administrator of the remote site.

The connection DNs are entered in a format that is dialable from the local site. 
Connection DN1 should be the least expensive means of calling the remote site. 
For example, if you use the ESN dialing plan between the sites, use the ESN 
prefix for connection DN1 and the PSTN number for connection DN2.

The system always uses DN1 to reply to a message from the remote site, unless 
it encounters problems. If the system does encounter a problem, it attempts to 
contact the remote site using another DN.

See also
For a general discussion of how connection DNs are used, consult 
“Understanding Integrated AMIS Networking settings” on page 71.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To configure a remote messaging server

1 In the Messaging Network Configuration tree view, select Remote Server 
Maintenance.

2 On the File menu, click New > Messaging Server.

Result: The Remote Messaging Server Properties dialog box appears.

3 On the General tab, in the Name box, enter the name of the remote 
messaging server.

4 Select the server type from the Server type box.
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5 In the Description box, enter details about the remote messaging server.

6 To enable the local messaging server to send messages to this remote 
messaging server, ensure that the Send Messages to this Server box is 
selected.

7 If an Enterprise site ID is required, enter the unique site ID number of the 
remote messaging server or a valid placeholder.

8 To continue configuring the remote messaging server, click the 
Connections tab.

9 From the Network protocol list, select AMIS.

Result: The Define buttons become enabled.

10 Click the Define button for DN1.

Result: The New DN dialog box appears. 

11 Enter the required DN.

■ For a public network, enter a public DN.

■ For a private network, enter a private DN.

12 Click Save.

Result: The DN appears in the Connection DNs box on the Connections 
tab.

13 Repeat steps 9–12 for each connection DN.

Note: DN1 is mandatory. At least one DN must be the system access 
number of the remote site.
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If you are defining more than one connection DN, list them in order of cost. 
Connection DN1 should be the least expensive means of contacting the 
remote site.

14 Click Save.

Result: The information is validated and entered into the network 
database.

What’s next?
After you add information about the remote messaging server into your local 
network database, you must also add information about the remote prime switch 
location.
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Configuring a remote prime switch location

Introduction
When you added a remote messaging server to the Message Network 
Configuration tree view, a corresponding prime switch location was added.

A remote prime switch location must be configured. This process is almost 
identical to configuring the local prime switch location.

Remote Prime Switch Location Properties dialog box
The remote prime switch location is configured on the Remote Prime Switch 
Location Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM

General tab
Completing the General tab is mandatory.

ESN tab
Complete the ESN tab if an ESN or hybrid dialing plan is used with this remote 
site.

CDP tab
Complete the CDP tab if a CDP or hybrid dialing plan is used with this remote 
site.

SMTP/VPIM tab
Because your local site is not using VPIM Networking to transfer messages with 
this remote site, do not complete the SMTP/VPIM tab.
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Remote Prime Switch Location Properties—General tab

Name
Assign a unique name to each switch location. The name should correspond to 
the switch location to make the location easy to identify. A street or city name is 
a good choice.

The remote switch location is automatically given the name of the remote server 
that was added to the Messaging Network Configuration tree view. This name 
can be changed.

Description
Enter short notes or comments about the remote switch location in this box.
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Enterprise Location ID
The Enterprise Location ID box is enabled only if Enterprise Networking is 
implemented on the local site.

A location ID is required for all remote sites if Enterprise Networking is 
installed locally, even if another protocol is used to exchange messages with this 
site.

The location ID of the prime switch location is set to 0 by default and cannot be 
changed.

Spoken Name Recorded
When local users compose a message to this remote site or use the playback 
feature to determine the sender of a message, they hear a message that identifies 
the sender. The content of the message depends on whether a spoken name for 
that remote site is recorded.

If a spoken name is recorded, voice mail users hear the location name followed 
by the local mailbox directory number.

Example: “Dallas, Mailbox 2346”

Spoken name not recorded
If a spoken name is not recorded, local users hear a full mailbox address that 
does not identify the sender’s site by name.

For example, for an ESN switch location, users hear the ESN location prefix 
followed by the local mailbox directory number.

Example: “Mailbox 6444 2346”

When a spoken name is not desirable
You may decide that you do not want local users to hear a spoken name for a 
particular remote site. For example, if CDP is used for messaging with this 
remote site and the mailbox numbers follow the dialing plan, you may decide 
that a recorded spoken name is unnecessary. In this case, do not record or import 
a spoken name.

Ways to add a spoken name recording
There are two ways to add a spoken name recording: record a spoken name 
directly by clicking the Record button, or import a prerecorded message.
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Dialing plan information
Provide general information on the dialing plan used by the switch.

The dialing plan boxes have complex interactions. They are dynamically 
enabled or disabled depending on the choices made. Complete all enabled 
boxes.

Dialing plans for dialing to this location 
You must specify which dialing plan is used to dial this remote switch location 
from the local switch location. There are four possible dialing plans:

■ ESN

■ CDP

■ hybrid combining ESN and CDP

■ another (such as PSTN)

Mailbox addressing follows dialing plan
When a mailbox follows the dialing plan, a user dials and addresses a message to 
a recipient in the same way. There are two ways to achieve this correspondence:

■ A user’s mailbox number and extension number are the same.

■ The addressing plan and the dialing plan are the same.

If either situation is true, select the Mailbox addressing follows dialing plan 
check box.

Clear this option if users at the site do not dial and address recipients in the same 
way.

Example: If the local ESN prefix is 6222 and the local mailbox is 1234, remote 
users can dial the local user with the number 62221234, which is the ESN prefix 
and the mailbox number combined.

Example: If the CDP steering code is 22 and the local mailbox is 1234, remote 
users can dial the local user with the number 221234, which is the steering code 
and the mailbox number combined.
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Mailbox prefixes
Mailbox prefixes are used by local users to address users at a remote site if 
mailboxes at the remote site do not follow the dialing plan.

A mailbox prefix must be provided if the mailbox does not follow the dialing 
plan or if another dialing plan, such as PSTN, is used.

A mailbox prefix does not have to overlap with local mailbox numbers. Two 
mailbox prefixes can be entered. Either prefix can be used to address any 
mailbox at the local site. Normally, however, only one prefix is required.

Usually, the mailbox prefix is a shortcut. A mailbox prefix can be any number as 
long as it does not conflict with other network data.

A mailbox prefix can also be the entire telephone number of the site, including 
country code, city/area code, and exchange.

Example: If the mailbox prefix is 22 and the mailbox number of a local user is 
6565, users at other switches address the local user by dialing 226565.

Dialing prefix
A dialing prefix is needed if the local site uses another dialing plan, such as 
PSTN, and users at your local site use dialing prefix to reach users at this remote 
site.

Usually, if the Dialing prefix box is enabled, you enter the prefix.

In a few cases, a dialing prefix is not needed. For example, if the mailbox 
number, without the mailbox prefix, can be dialed directly, a dialing prefix is not 
needed. This situation is rare because most systems use at least some sort of 
access code.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To configure a remote prime switch location

1 In the Messaging Network Configuration tree view, select the remote prime 
switch location.

2 On the File menu, select Properties.

Result: The Remote Prime Switch Location Properties dialog box appears.
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3 On the General tab, in the Name box, enter the name of the remote prime 
switch location.

4 In the Description box, enter details about the switch location.

Note: The Enterprise Location ID is always set to 0 for remote prime switch 
locations and cannot be changed.

5 If needed, click Record to record a spoken name for the site, or click Import 
to import a prerecorded spoken name.

Note: For instructions on how to record a spoken name, see “Recording a 
spoken name” on page 199.

For instructions on how to import a spoken name, see “Importing a spoken 
name” on page 201.

6 Specify the dialing plan used to dial the remote site. Select the

■ ESN check box if ESN is used

■ CDP check box is CDP is used

■ ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if you use another dialing plan, such as 
PSTN.

7 Indicate if mailbox addressing follows the dialing plan.

8 If necessary, enter the mailbox prefix or prefixes.

9 If necessary, enter the dialing prefix.

ESN information
If the remote prime switch location uses an ESN or hybrid dialing plan, 
complete the ESN tab.

The procedure for configuring the ESN information for a remote prime switch is 
identical to the procedure used for the local prime switch location.

Note: You must provide the ESN access code used at the remote site. Do not 
enter the access code used locally.

For a review of the ESN access codes, ESN location codes, and overlap, consult 
“Configuring ESN information” on page 165.
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To configure the ESN information

1 Open Message Delivery Configuration > Switch Location > ESN tab.

2 Enter the ESN access code.
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3 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

4 In the Location Code box, enter the location code.

5 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the location code.

6 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes box on the ESN tab.

7 Repeat steps 3–6 for each ESN location code required.

8 When you have finished configuring the ESN information, determine if you 
must configure CDP information. If yes, click the CDP tab. If no, click Save.

What’s next?
If your remote prime switch location uses the hybrid dialing plan, click the CDP 
tab to continue configuring the local prime switch location.

If the local prime switch location uses only the ESN dialing plan, click Save to 
validate the configuration information and save it to the network database.

. 
Integrated AMIS Networking Implementation and Administration Guide 191



Adding sites to Integrated AMIS Networking  Standard 1.0
CDP information
If a CDP dialing plan or a hybrid dialing plan is used to connect the local site to 
the remote site, complete the CDP tab.

Configuring the CDP information for a remote prime switch location is identical 
to configuring the local prime switch location.

For a review of the CDP steering codes and overlap, consult “Configuring CDP 
information” on page 169.
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To configure the CDP information

1 Open Message Delivery Configuration > Switch Location > CDP tab.

2 Click the Add New button.

Result: The New CDP Steering Code Properties dialog box appears.
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3 In the Steering Code box, enter the steering code.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the steering code.

5 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Codes box on the CDP tab.

6 Repeat steps 2–5 for each CDP steering code required.

7 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and added to the network database.

What’s next?
You have completed the configuration of the remote prime switch location.

Click Save to validate the information and save it to the network database.

The Remote Prime Switch Location Properties dialog box closes, and you return 
to the Messaging Network Configuration tree view.
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Configuring a remote satellite switch location

Introduction
If a remote site is an NMS site, you must add and configure each of its satellite 
switch locations. This information is saved to the local network database.

Although a prime switch location is added automatically when a remote site is 
added to the Messaging Network Configuration tree view, you must manually 
add each satellite switch location of a remote NMS site.

Capacity
An NMS site can have up to 59 satellite switch locations.

Organization
When you add a satellite switch location, this location appears in the Messaging 
Network Configuration tree view. Satellite switch locations are listed 
alphabetically below the prime switch location.

Where to configure a satellite switch location
To configure a satellite switch location, complete the General tab of the Remote 
Satellite Switch Location Properties dialog box.

You must also complete the tabs that correspond to the dialing plan used by the 
local site.

ESN tab
Complete the ESN tab if you use an ESN or hybrid dialing plan.

CDP tab
Complete the CDP tab if you use a CDP or hybrid dialing plan.
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Spoken Name Recorded
When local users compose a message to a remote satellite switch location or use 
the playback feature to hear who sent a message, the name of the switch location 
is played. 

If a spoken name is not recorded, local users hear the full DN, such as “Mailbox 
64441234.” If a recording of the spoken name is available, local users hear the 
switch location name followed by the mailbox number, such as “Milan 1234.” 
You can either record a message using the telephone or import a prerecorded 
WAV file.

When a recording of the spoken name is available, Yes appears in the Spoken 
Name Recorded box.

If you do not want your local users to hear the name of this satellite switch 
location when composing messages or using playback, do not record a message. 
For example, if you are using CDP to transfer messages to the site and mailbox 
numbers follow the dialing plan, you may feel that a spoken name is 
unnecessary.

Dialing plan interaction
The dialing plan boxes are dynamically enabled or disabled depending on the 
choices made. Complete all enabled fields. 

See also
Configuring a satellite switch location for a remote site is  identical to 
configuring a remote prime switch location for a remote site. 

For a review, consult “Configuring a remote prime switch location” on page 
184.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure a remote satellite switch location

1 On the Messaging Network Configuration tree view, highlight the remote 
messaging server.

2 On the File menu, select New > Switch location.

Result: The Satellite Switch Location Properties dialog box appears.

3 In the Satellite Switch Location Properties dialog box, complete the General 
tab.

Note: For detailed instructions on how to record a spoken name, consult 
“Recording a spoken name” on page 199. For detailed instructions on how 
to import a spoken name, consult “Importing a spoken name” on page 201.

4 Complete the ESN tab and the CDP tab as required.
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5 Click Save.

Result: The information is validated and the satellite switch location is 
added to the remote site.

6 Repeat steps 1–5 for each satellite switch location required.

7 When all satellite switch locations are added, click Save to save them to the 
Messaging Network Configuration tree view.
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Recording a spoken name

Introduction
You can create a recording of the name of a switch location. A recorded name is 
heard by a local user whenever an address is played back. A recorded name for a 
site is played if a user does not have a personal recorded name.

Local switch location
If your local site is not an NMS site, a spoken name is not required for the local 
site.

If your local site is an NMS site, you can decide if you want to record a spoken 
name. For example, if the NMS site uses CDP, you may decide a spoken name is 
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote site.

Importing a spoken name
If you do not want to record your own voice using the telephone, you can import 
a prerecorded WAV file. See “Importing a spoken name” on page 201.
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Before you begin
A telephone serves as the microphone. Therefore, if you want to record a spoken 
name, a telephone must be available.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To record a spoken name

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to record a spoken name.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Record.

Result: The Specify Phoneset dialog box appears.

4 Enter the telephone number of the telephone to be used as a microphone 
and click Dial.

Result: The telephone rings and the Voice Recorder dialog box appears.

5 Answer the telephone.

6 In the Voice Recorder dialog box, click Record.

7 Speak the name of the site into the telephone.

8 Click Stop.

9 To review the recording, click Play.

10 If you are satisfied with the recording, click Done.
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Importing a spoken name

Introduction
You can import a prerecorded file of the name of a switch location. The 
recording is heard by a local user whenever an address is played back. A 
recording for a site is played if a user does not have a personal spoken name.

Local switch location
If your local site is not an NMS site, a spoken name is not required for the local 
site.

If your local site is an NMS site, you can decide if you want to import a spoken 
name. For example, if the NMS site uses CDP, you may decide a spoken name is 
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote site.

Recording a spoken name
If you do not want to import a prerecorded spoken name, you can record your 
own voice message using the telephone. See “Recording a spoken name” on 
page 199.

Before you begin
A prerecorded WAV file must be available. Check the quality of the recording 
before importing the file.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To import a prerecorded file

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to import a prerecorded file.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Import.

Result: The Open dialog box appears.

4 Select the WAV file, and click Open.

Result: The file is imported.

5 Close the Open dialog box.
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Non-CallPilot remote sites

Introduction
Integrated AMIS Networking can exchange messages between a CallPilot 
system and the following non-CallPilot remote systems:

■ a  Meridian Mail (Release 8 and later) system

■ a Norstar Voice Mail (Release 3 and later) system

Coordination
If a remote site is a non-CallPilot system, you must coordinate with the network 
administrator of that remote site to ensure that the systems are properly 
configured. You must share the standard information that is required between 
any sites in a messaging network.

Example
The two sites must coordinate dialing plans and ensure that there are no conflicts 
in the configuration information.

Terminology
A change in terminology may cause some confusion.

In Meridian Mail and Norstar Voice Mail, the name is Virtual-Node AMIS 
Networking, rather than Integrated AMIS Networking is used. The two are 
identical products.

Adding and configuring the remote site
Adding a non-CallPilot remote site to the local network database is exactly the 
same as adding a CallPilot remote site.

To configure the non-CallPilot remote site, you require no special information. 
You must only specify the server type on the Remote Messaging Server dialog 
box. The rest of the configuration is the same as the configuration of a CallPilot 
remote site.
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Server type
Specify the server type of a non-CallPilot system on the Messaging Network 
Configuration—Remote Server Properties—General tab.

Instructions for the remote administrator
For both Meridian Mail and Norstar Voice Mail systems, there are no special 
considerations that must be communicated to the remote network administrator.

You add the CallPilot site to the remote network database like any other remote 
site. No special configuration is required.
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Meridian Mail remote sites

Introduction
Integrated AMIS Networking can exchange messages between a CallPilot 
system and a Meridian Mail (Release 8 and later) system.

Instructions for the remote Meridian Mail administrator
You add the CallPilot site to the network database like any other site. There are 
no special considerations that must be communicated to the remote network 
administrator.
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Norstar Voice Mail remote sites

Introduction
Integrated AMIS Networking can exchange messages between a CallPilot 
system and a Norstar Voice Mail (Release 3 and later) system.

Instructions for the remote Norstar Voice Mail administrator
You add the CallPilot site to the network database like any other site. There are 
no special considerations that must be communicated to the network 
administrator.
206 CallPilot
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Testing and backing up Integrated 
AMIS Networking

This chapter describes how to test the Integrated AMIS Networking 
configuration. The test suite determines if Integrated AMIS Networking works 
properly both locally and with remote sites.

This chapter also describes how to create a backup of your system to ensure that 
the configuration is not lost due to system failure.

In this chapter
Tests and backups 209
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Tests and backups

In this section
Integrated AMIS Networking test suite 210

Call routing test 212

Local SDN test 213

Quick SDN test 215

Loopback test 217

End-to-end test 219

Backing up Integrated AMIS Networking 222
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Integrated AMIS Networking test suite

Introduction
After you configure CallPilot for Integrated AMIS Networking, test the system.

The Integrated AMIS Networking test suite tests every aspect of the system. If 
any test fails, resolve the problem and retry the test before you continue.

Note: These tests are not intended to validate the AMIS compliance of a third-
party system. The tests assume that any system that you communicate with is 
AMIS-compliant.

Test suite
The Integrated AMIS Networking test suite consists of five tests. Two tests are 
local site tests, which verify that your local configuration is correct. Three tests 
are coordinated site tests, which verify that everything works properly at your 
site and at every remote site.

The following table lists the local site tests and describes their purpose:

The following table lists the coordinated site tests and describes their purpose:

This local site test Determines if

call routing test ■ the local system can make outbound 
calls to other sites in the network.

■ the local system cannot make 
outbound calls to restricted sites on the 
network.

local or quick SDN test ports on CallPilot are working properly, 
and SDNs are defined correctly.

This coordinated site test Determines if

end-to-end test a remote system can receive messages 
from the local system.
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Coordination
While you can perform local site tests independently, you must work with the 
network administrators at each remote site to perform the coordinated site tests.

In some instances, the remote administrator must make preparations before you 
can conduct the test. For example, to complete the loopback test, the remote 
network administrator must create a loopback mailbox.

If a test is unsuccessful and you do not find the cause of the problem locally, 
work with the remote administrators to determine the cause of the problem.

For quick results
When you test your implementation of Integrated AMIS Networking, there are 
two ways to ensure quick results:

■ Change the batch threshold to 1.

■ Tag a test message as an urgent priority message.

An urgent tag ensures quick results. You do not need to change the scheduling 
parameters to perform the tests and return them to their original settings after 
you complete the tests.

Note: An urgent test message is handled according to set scheduling parameters. 
For example, if the urgent message hold time is five minutes, it may take five 
minutes before the test message is sent.

loopback test the local system can receive messages 
from the remote system.

This coordinated site test Determines if
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Call routing test

Introduction
The call routing test determines if the local system

■ can make outbound calls to other sites using Integrated AMIS Networking

■ cannot make outbound calls to numbers that are configured as restricted on 
the system

Before you begin
Ask the switch technician for the ACD/UCD agent and trunk printouts for the 
switch.

To perform the call routing test

1 Use the ACD/UCD agent and trunk printouts to select an ACD/UCD agent.

2 Program a telephone to use the same NCOS and TGAR as the agent.

Note: For instructions, consult your switch documentation.

3 Dial a network address.

4 Repeat steps 1–3 for a number that you know should be restricted.

Example: Attempt to access a trunk directly.

Evaluating test results
The call routing test is successful if an outbound call goes through to the allowed 
system but is blocked to a restricted system.

If the test is not successful
If the call routing test fails or produces unexpected results, a switch technician 
must check the switch settings that control routing and restrictions on calls.

What’s next?
After you successfully complete the call routing test, perform the local SDN test.
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Local SDN test

Introduction
The local SDN test verifies that the local system can receive messages from a 
remote system. This test confirms that the SDN for Integrated AMIS 
Networking in the SDN Table is correct.

The quick SDN test can be substituted for the local SDN test. See “Quick SDN 
test” on page 215.

Note: The SDN for Integrated AMIS Networking is, by default, the same default 
used by AMIS Networking.

If Integrated AMIS Networking and AMIS Networking share an SDN with 
another service, send the message to that SDN when you enter the system access 
number.

The SDN test consists of sending a message to a mailbox at your local site. You 
address the message as if it is being sent to an Open AMIS site. You enter the 
system access number in dialable format. For this test, the system access number 
consists of the following:

■ the access code required to dial out of the system

■ your local site’s number, including the exchange code and SDN

To perform the SDN test

1 Log in to CallPilot.

2 Press 75 to compose a message.

3 Enter the following:

■ the AMIS compose prefix

■ the system access number

■ # to indicate the end of the system access number
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4 Enter the local mailbox number on which you are currently logged, followed 
by #.

Result: The system responds with the following message: Open network 
user <mailbox number> at <system access number>.

5 Press # again to indicate the end of the list of recipients.

6 Press 5 to record a message.

7 Record the message.

8 Press # to stop the recording.

9 Tag the message as urgent.

10 Press 79 to send the message.

Result: The system responds with the following message: Message 
sent.

11 Log off.

Evaluating test results
The message is sent according to the scheduling parameters for urgent messages.

The test is successful if you receive the message you recorded.

The test is not successful if you receive a non-delivery notification message.

If the test is not successful
If the SDN test is not successful, check the Integrated AMIS Networking SDN 
in the SDN Table. Review the SDN setup requirements and make any necessary 
adjustments.

See also
For an overview of setting up SDNs, consult the Advanced Administration 
Guide.

For a detailed discussion of setting up SDNs for Integrated AMIS Networking, 
consult “SDN Table and Integrated AMIS Networking” on page 106.

What’s next?
After you successfully complete the SDN test, perform the loopback test.
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Quick SDN test

Introduction
The quick SDN test verifies that the local system can receive messages. This test 
confirms that Integrated AMIS Networking is correctly configured in the SDN 
Table.

The quick SDN test does not require the participation of a remote network 
administrator.

The local SDN test can be substituted for the local SDN test. See “Local SDN 
test” on page 213.

To perform the quick SDN test

1 Log in to CallPilot.

2 From your local telephone, enter the local SDN for Integrated AMIS 
Networking.

3 Listen for the system to answer the call.

4 Repeat these steps for every SDN used by Integrated AMIS Networking.

Evaluating test results
The quick SDN test is successful if the system answers and waits for a C-tone. 
The system times out after approximately 20 seconds.

The test is not successful if any prompts are heard.

If the test is not successful
If the quick SDN test is not successful, check the Integrated AMIS Networking 
SDNs in the SDN Table. Review the SDN setup requirements and make any 
necessary adjustments.
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See also
For detailed information on setting up SDNs, consult the Advanced 
Administration Guide.

What’s next?
After you successfully complete the quick SDN test, perform the loopback test.
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Loopback test

Introduction
A loopback test confirms that a message can be sent from a local site to a remote 
site, and returned to the local site.

You should perform this test after you add each remote site to the local database.

To perform the loopback test, compose and send a message to a loopback 
mailbox at a remote site. A loopback mailbox automatically returns a message to 
the originator.

Before you begin
Before you perform the loopback test, you must ensure that a loopback mailbox 
exists on each remote site tested.

Loopback mailbox
A loopback mailbox is a mailbox that is set up on every site in the messaging 
network. The only purpose of a loopback mailbox is to return a confirmation of 
receipt.

Get the loopback mailbox number from the network administrator of each 
remote site with which you are performing the Integrated AMIS loopback test.

To perform the loopback test

1 Log in to CallPilot.

2 Press 75 to compose a message.

3 Enter the network address of the remote site.

4 Enter the loopback mailbox number of the remote site.

5 Press 5 to record a message.

6 Record the message, and press # to stop recording.

7 Tag the message as urgent.

8 Press 79 to send the message.
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9 Wait for your Message Waiting Indicator light to activate.

Note: This light indicates that the message was successfully returned to 
you. Activation may take several minutes.

10 Log in and listen to the message.

11 Log out of the system.

Evaluating test results
The test is successful if you hear the message that you recorded.

The message is not successful if you receive a non-delivery notification 
message.

If the test is not successful
If the test is not successful, do the following:

■ Check with the remote network administrator and confirm the loopback 
mailbox number.

■ Perform the test again to ensure that the message was addressed correctly.

■ Consult the operational measurement reports to determine the following:

● Are the connection DNs correct?

● Is the remote site operational?

● Do the message transfer protocols match?

What’s next?
After you successfully complete the AMIS loopback test, perform the end-to-
end test.
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End-to-end test

Introduction
An end-to-end test verifies that users at a remote site can receive messages from 
users at the local site.

To perform the end-to-end test, send a message to a mailbox at a remote site. 
Send the test message to the mailbox of the remote network administrator and 
request a confirmation.

Before you begin
You must coordinate with the remote network administrator of each site with 
which you wish to perform a loopback test. Each remote administrator must 
listen to the message you have sent before returning an acknowledgment.

To perform the end-to-end test

1 Log in to a mailbox.

2 Press 75 to compose a message.

3 Enter the mailbox address for a mailbox at a remote site.

4 Press #.

5 Press # again.

6 Press 5 to record a message.

7 Record the message, and then press # to stop the recording.

8 Tag the message as urgent.

9 Press 79 to send the message.

10 Log out of the system and hang up.

11 Ask the remote administrator to log in to the mailbox and listen to the 
message.

12 Wait for an acknowledgment to be returned to you.

13 Log in to the mailbox and listen to the acknowledgment.
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Evaluating test results
The test is successful if the message is successfully delivered to the remote 
system.

The test is not successful if a non-delivery notification (NDN) is received, which 
indicates that the message was not received.

Confirming successful delivery
Even if you do not receive an NDN, you may want to confirm that the message 
was successfully delivered.

To confirm the delivery, either

■ log on to the remote site and read the message, or

■ ask the administrator at the remote site to log on and read the message

If the test is not successful
If the end-to-end test fails or produces unexpected results, check the following:

■ Was the message correctly addressed?

■ Does the mailbox on the remote system exist?

■ Does the NDN provide any indication of the problem?

If you receive an NDN, listen to the message to determine why the test 
message was not delivered.

IF the NDN states THEN

it took too many attempts to send 
the message

the cause may be

■ incorrect message transfer protocol.

■ incorrect site ID.

■ incorrect connection DN.

■ incorrect passwords.

■ the remote site is disabled.
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■ Do the Alarm and Event reports provide details of the possible causes?

Since all previous tests have been successfully completed, the remote site 
probably caused the test to fail.

Examples of remote site causes include the following:

● Incorrect password pairs were assigned between sites.

● Channels were not available.

● Addresses were incorrect.

● Connection DNs do not terminate on the networking DN.

● A remote site that is not yet operational was specified.

What’s next?
The end-to-end test is the final test in the Integrated AMIS Networking test 
suite. When you successfully complete the end-to-end test, perform a backup of 
your configuration.

the address was incorrect the message was delivered to the remote site 
but could not be delivered. The cause may 
be

■ the mailbox does not exist.

■ the wrong mailbox number was used.

■ the Receive Composed Messages box on 
the Class of Services screen is set to No.

■ the disk at the remote site is full.

IF the NDN states THEN
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Backing up Integrated AMIS Networking

Introduction
When all tests of the system are successfully completed and Integrated AMIS 
Networking is working properly, perform a backup.

The backup ensures that the configuration is not lost due to system failure.

Backup schedule
Perform a manual backup as the final step in the AMIS Networking installation. 

Note: You must perform a manual backup even if the system is configured to 
perform an automatic backup. 

In the unlikely event that the system experiences a disk failure before the 
automatic backup takes place, the networking configuration could be lost.

Whenever you modify Integrated AMIS Networking information during regular 
maintenance, perform a backup.

System backup components
A system backup consists of two parts:

■ switch backup

■ CallPilot backup

Switch backup
For detailed instructions on how to perform a switch backup, consult your 
switch documentation.

CallPilot backup
You can perform a full or partial backup of your CallPilot server. For detailed 
instructions on how to perform a CallPilot backup, consult the Advanced 
Administration Guide.
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Maintaining Integrated AMIS 
Networking

After you complete the Integrated AMIS Networking implementation, you only 
need to perform regular maintenance. 

This chapter describes maintenance procedures that must be performed 
regularly. The chapter also describes maintenance procedures that you perform 
only when required.

In this chapter 
About maintaining Integrated AMIS Networking 225

Regularly scheduled maintenance tasks 231

As-required maintenance tasks 233
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About maintaining Integrated AMIS 
Networking

In this section
Overview 226

Maintain a network history 228

Printing configuration information 229
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Overview

Introduction
After you successfully install and test Integrated AMIS Networking, the system 
only requires maintenance. You need to perform two types of maintenance tasks:

■ regularly scheduled

■ as-required

Regularly scheduled tasks
Regularly scheduled tasks include

■ checking the network status

■ reviewing Operational Measurement (OM) reports

Although you can perform regularly scheduled tasks at any time, perform these 
tasks at least once a week. Since these tasks do not interfere with the operation 
of  Integrated AMIS Networking, you can schedule them at a convenient time 
during a regular workday.

If you monitor the performance of your messaging network, you avoid future 
problems. Careful monitoring shows bottlenecks in the system and indicates 
how the system can be improved.

Monitoring can also help you to plan and forecast future messaging network 
requirements.

As-required tasks
Perform as-required tasks as needs arise. As-required tasks include

■ modifying networking parameters

■ disabling and enabling Integrated AMIS Networking

■ modifications to the Integrated AMIS Networking configuration
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When to perform as-required tasks
Since as-required tasks may affect the entire system, perform these tasks when 
the system is not in heavy use.

Modifications to the configuration may be necessary for the following reasons:

■ New legal delivery times are announced for computer-generated calls.

■ The system performance suggests that adjustments to the parameters are 
required.

■ The system access number is changed.

Perform a backup following maintenance
Perform a backup of the system whenever you modify the network parameters as 
part of your maintenance.

ATTENTION! Because as-required tasks may affect the performance of 
the entire system, schedule them for off-peak hours.
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Maintain a network history

Introduction
Keep detailed records of your network’s history. These records can

■ Indicate significant performance or equipment issues that real-time 
monitoring may not detect.

■ Provide a background for comparing the current information.

■ Provide information needed during support calls.

Information to record
A network history should contain the following types of information:

■ installation dates and descriptions

■ contact information for all key personnel involved in the system installation 
and configuration

■ details of software installed on the messaging server, including versions

■ installation process and results, including tests

■ diagrams of the initial and subsequent network configurations

■ any problems encountered and their solutions

■ hardware and software changes

■ changes to the messaging network layout

Where to keep the records
Make the records of your messaging network easy to access and easy to read. 
Graphics, including hand-drawn sketches, can be very useful.

Keep records in a log or online. Note, however, that online records cannot be 
accessed if the system fails.

See also
For a detailed description of messaging network histories, consult the 
Networking Planning Guide.
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Printing configuration information

Introduction
Printouts of the system configuration are often included in a network history. 
You can print all configuration information contained in your local network 
database.

To print configuration information, you must open the relevant Properties dialog 
box. For example, to print an item in the Messaging Network Configuration tree 
view, you must open the Properties dialog box of the item.

If a Properties dialog box consists of more than one tab, the contents of all tabs 
are printed.

Note: You cannot print the tree view of the messaging network contained in the 
Messaging Network Configuration dialog box.

When to print configuration information
Although configuration information is always available in the most recent 
backup of your network database, you may find it convenient to make printouts 
as well.

Printouts of the configuration information are especially useful in the following 
situations:

■ You must fax information to a remote network administrator.

■ You are keeping a network history.

■ You are planning to change a configuration or delete an item from the 
Messaging Network Configuration tree view, and you want a hard copy of 
the original configuration.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration or Messaging 
Network Configuration

To print configuration information

1 Open the dialog box that you want to print.

2 With the dialog box open, click the Print button.

Result: The contents of the dialog box print. The printout includes the 
contents of all tabs.
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Regularly scheduled maintenance tasks

In this section
Reviewing OM reports and alerts 232
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Reviewing OM reports and alerts

Introduction
Operational Measurement (OM) reports show how much of the CallPilot system 
is being used by AMIS Networking.

Three OM reports provide AMIS Networking information:

Although you can review OM reports at any time, you should review them at 
least weekly.

Access to OM reports is restricted
The generation of OM reports is a restricted activity that is determined by access 
level. If you do not have the necessary access, you must ask your system 
administrator to generate the reports.

The OM report request screens let you choose the reports that you want to view 
and print. For many reports, you can also customize the displayed results so that 
you receive the information in a format that best suits your needs.

See also
For more information on OM reports, including how to interpret them, consult 
the Reporter Guide.

This OM report provides

Open Networking Activity information about open networking activity 
over a specified time interval.

Network Usage Bill-back information to bill back the cost of users’ 
networking activities.

Failed Networking Sessions 
alert

notification that the number of networking 
failures equals or exceeds the total number of 
networking attempts.
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As-required maintenance tasks

In this section
Overview 234

Modifying the configuration of Integrated AMIS Networking 236

Disabling and enabling Integrated AMIS Networking 238

Modifying message delivery parameters 241

Modifying the channel resource allocation 243

Add, modify, or delete remote sites 245

Locating an item in the tree view 247

Modifying a remote site configuration 248

Deleting items in the tree view 251

Modifying dialing plan information 254
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Overview

Introduction
You may need to modify the Integrated AMIS Networking configuration, 
including

■ whether the system can send or receive AMIS messages

■ the time periods when outgoing messages are allowed to be sent during 
business and nonbusiness days

■ the minimum and maximum port allocation for AMIS Networking

■ how many messages to transmit in each AMIS Networking session

■ the scheduling parameters

Scheduling parameters
The scheduling parameters that may be modified are

■ economy message send time

■ stale times for economy, standard, and urgent messages

■ batch threshold

■ delivery days and times

Identifying required modifications
Changes to the Integrated AMIS Networking configuration may be required if

■ Message delivery scheduling is not performing as anticipated.

■ There are changes to the long-distance charge period or to delivery days 
and times.

■ There are changes to network traffic to and from Open AMIS sites.
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Example 1
When you originally configured the system, you set the economy delivery start 
time to 8:00 p.m. and the stale time to 4 hours. Users find that many of their 
messages are going stale and are being returned with non-delivery notifications.

A coordination problem exists between the two scheduling parameters. If you 
compose an economy message in the morning, it may go stale before the 
delivery time begins. Therefore, you must reconfigure the stale time to 20 hours, 
for example. This reconfiguration ensures that messages can be composed 
throughout the business day and will not go stale before the delivery begins.

Example 2
When you originally configured Integrated AMIS Networking, the lower rates 
for long distance came into effect at 11:00 p.m. Therefore, you set the economy 
delivery start time to 11:00 p.m.

However, the telephone company has announced new periods for lower long-
distance toll rates. Lower rates now begin at 8:00 p.m. Therefore, you change the 
economy delivery start time to 8:00 p.m.
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Modifying the configuration of Integrated 
AMIS Networking

Introduction
If you need to modify the Integrated AMIS Networking configuration, follow 
these general guidelines.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 or AMIS 
2 tab

To modify the Integrated AMIS Networking configuration

1 Review Chapter 5, “Configuring CallPilot for Integrated AMIS Networking”, 
to ensure that you understand the impact of the changes.

2 Enter all required modifications on the AMIS 1 and AMIS 2 tabs.

3 Click Save.

Result: The system validates the modifications and, if they are valid, puts 
the modifications into operation immediately.

CAUTION!
. 

Risk of loss of functionality
Changes to the networking configuration should be done 
during hours when users are not logged on. Making changes 
to the configuration while users are logged on may result in 
loss of messaging functionality.
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Announce some modifications
Most of the modifications that you make to the Integrated AMIS Networking 
configurations are transparent to your users. Although modifications may affect 
the performance of the system, they do not require any new input from users.

However, if you modify the AMIS compose prefix, you must announce this 
change to all local users.

If you modify the SAN, you must notify remote callers about this change. Also 
remind your local users to tell users at the open sites about the changes.

Perform a backup
After you modify the configuration of Integrated AMIS Networking, perform a 
backup to ensure that these changes are not lost.

Also record the changes in your network history.
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Disabling and enabling Integrated AMIS 
Networking

Introduction
You may need to disable Integrated AMIS Networking occasionally. When you 
disable Integrated AMIS Networking, users cannot compose, send, or receive 
AMIS messages.

You might disable Integrated AMIS Networking to

■ Prevent system abuse.

■ Temporarily suspend outgoing or incoming messages, or both.

Messages sent while system is disabled
When you disable outbound Integrated AMIS Networking, your local users can 
continue to compose and send messages. The messages composed by your local 
users are held in queue until the option is enabled or the message becomes stale.

When you disable inbound Integrated AMIS networking, messages from remote 
systems are rejected. The remote system that sends the message is informed of 
the status, and messages are not accepted. The way the remote system handles 
this information depends on the system. For example, if the remote system is 
CallPilot, the sender receives a non-delivery notification that states that the 
system of the intended recipient is not accepting messages. AMIS-compliant 
systems from other vendors may handle this scenario differently.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 tab

To disable and enable Integrated AMIS Networking

1 Do the following:

2 To save your settings, click Save.

Other ways to disable and enable Integrated AMIS Networking
There are several ways to disable and enable Integrated AMIS Networking. Use 
the most appropriate method, depending on the circumstances.

In addition to the Message Delivery Configuration method described above, the 
following methods are available:

IF you want to THEN

disable your system from receiving 
AMIS messages

clear the Incoming AMIS 
Networking check box.

disable your system from sending AMIS 
messages

clear the Outgoing AMIS Networking 
check box.

enable your system to receive AMIS 
messages

select the Incoming AMIS 
Networking check box.

enable your system to send AMIS 
messages

select the Outgoing AMIS 
Networking check box.

IF you want to THEN

disable the sending and receiving 
of Integrated AMIS Networking 
messages by user class of service

set this option in Basic Administration.

disable or restrict the sending of 
Integrated AMIS Networking 
messages to specific or all SANs 
by a user

change the AMIS Restriction/Permission 
List for the user.
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disable the sending of messages 
to any remote site, using any 
protocol, by the local server

clear the Send Messages to all other Servers 
option in the Messaging Network 
Configuration dialog box for the local 
server.

Note: This option is available only if 
additional networking solutions are 
installed on your local system.

disable the sending of messages, 
using the defined protocol, to a 
specific remote site

clear the Send Messages to all other Servers 
option in the Messaging Network 
Configuration dialog box for the remote 
server.

Note: This option is available only if 
additional networking solutions are 
installed on your local system.

IF you want to THEN
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Modifying message delivery parameters

Introduction
Message delivery parameters control when and how Integrated AMIS 
Networking sends messages. You can modify the following message delivery 
parameters as required:

■ batch threshold

■ stale times

■ AMIS compose prefix

■ economy delivery start and stop times

■ AMIS delivery times

Impact of modifications
The message delivery parameters are closely interrelated. Modifications to one 
parameter may necessitate changes to others. Therefore, carefully plan 
modifications in advance.

You must test and monitor the performance of the system after you make any 
modifications to ensure that the modifications have the desired effect and no 
unplanned side effects.

Note: Before you modify the message delivery parameters, review the previous 
discussion of how these parameters are set. Review Chapter 5, “Configuring 
CallPilot for Integrated AMIS Networking”.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 and 
AMIS 2 tabs

To modify message delivery parameters

1 Modify the delivery parameters on both tabs as required.

2 Review the changes to ensure that there are no conflicts among the 
parameters.

3 Click Save.

Perform a backup
After any modification to the configuration, perform a backup to ensure that the 
modification is not lost.
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Modifying the channel resource allocation

Introduction
When you implemented Integrated AMIS Networking, you set the minimum and 
maximum channel resource allocation for both the inbound and the outbound 
Integrated AMIS Networking SDNs. The channel resources determine how 
efficiently services are accessed.

Balance channel resources
You must carefully balance channels for each service when you allocate channel 
resources. You must allocate enough channels to ensure that users can access the 
service. However, you must not overallocate channels so that users are unable to 
access other services.

Determine if modifications are necessary
To determine if modifications to the channel resource allocation are necessary, 
monitor service usage. After Integrated AMIS Networking is in service for a 
period of time, use the Reporter feature to determine how services are being 
used.

Reporter provides the following statistics:

■ the number of calls queued for a service

■ the average wait time for queued calls

■ the maximum wait time for queued calls

■ the number of callers who abandoned the queue

If you are dissatisfied with the performance of Integrated AMIS Networking 
after analyzing these statistics, modify the resource allocation. However, 
remember that modifications to the resource allocation for one service may 
affect the performance of other services.
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Getting there  Nortel SMI > Meridian Application Server > System 
Configuration > Service Administration > Service Directory 
Number > Service Directory Number Table

To modify an SDN

1 In the SDN Table, select the SDN you want to modify.

2 On the File menu, select Properties.

Result: The Edit Service Directory Number Properties dialog box appears.

3 Make the necessary modifications.

4 Click Save.
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Add, modify, or delete remote sites

Introduction
As your messaging network grows and changes, you may need to add, modify, 
or delete a remote site.

Note: It is very important that all network administrators keep the information in 
their network database up-to-date.

Before you begin
Before you add, modify, or delete a remote site, print all configuration 
information that will be affected.

Add a remote site
When you add a site to the messaging network, all sites add the new site to their 
Messaging Network Configuration tree view. The remote administrator must 
provide the information necessary to add and configure a remote site.

Modify a remote site
You can modify the configurations of both the messaging server and the switch 
locations as needs change. For example, if a remote site upgrades its system, you 
must modify its configuration information in your network database.

It is important that the information in your network database reflect the actual 
configuration of the remote site. The remote network administrator must inform 
you of all necessary changes.
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Delete a remote site
When you remove a site from the messaging network, all sites must delete it 
from their Messaging Network Configuration tree view.

Impact on network database
Your network database reflects any additions, modifications, or deletions to 
remote sites. For this reason, you should perform the Integrated AMIS 
Networking test suite again, as well as a backup.
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Locating an item in the tree view

Introduction
It can be difficult to locate a particular remote site, messaging server, or switch 
location in the Messaging Network Configuration tree view in a large messaging 
network.

There are two ways to locate an item in a large messaging network:

■ Scroll through the alphabetized list.

■ Use the Find feature.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To locate an item using Find

1 On the File menu, select Find.

Result: The Find dialog box appears.

2 Enter the name of the item to be located, and press the Find button.

Result: The located item is highlighted in the Messaging Network 
Configuration tree view.
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Modifying a remote site configuration

Introduction
Modify the configuration of a remote site as required.

To modify a remote site, you must open the Messaging Network Configuration 
tree view and select the remote messaging server or switch location that you 
wish to modify.

Further information
Make modifications to the configuration on the Properties dialog box where the 
initial configuration was made. To review the settings, consult the instructions 
for the initial configuration.

Impact of modifications
When you modify the configuration of a remote system,  networking service 
between the remote site and your local site may be affected. Modifications to the 
following settings are especially important:

■ site IDs

■ connection DN

■ dialing plans

■ message transfer protocol

To review the settings on this 
Properties dialog box Consult the instructions found here

Remote Messaging Server “Configuring a remote messaging server” 
on page 175.

Remote Prime Switch location “Configuring a remote prime switch 
location” on page 184.

Remote Satellite Switch Location “Configuring a remote satellite switch 
location” on page 195.
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Enterprise Site IDs
Do not change the remote Enterprise Site ID unless the administrator at the 
remote site notifies you of a change in that ID, or if the ID is incorrect.

If you change the site ID to an invalid number by mistake, the system is unable 
to send or receive messages from the site.

Connection DN
Do not change the connection DN to a remote site unless

■ the administrator at the remote site notifies you that the DN in the SDN 
Table is changed, or

■ you are changing the message transfer protocol

Dialing plans
Do not change the dialing plan unless the dialing plan on the switch is changed.

Network protocol
Do not change the network protocol configured for a remote site unless the 
network administrator of the remote site advises you to do so. Changing the 
network protocol used between two sites requires considerable reconfiguration.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To modify the configuration of a remote site

1 In the Messaging Network Configuration tree view, select the remote 
messaging server or servers that you want to modify. 

2 On the File Menu, select Open.

Result: The Properties dialog box for the selected item opens.

3 Make all required modifications.

4 Click Save.

Result: The modifications are validated and saved to the network 
database.

5 Repeat steps 1–4 for all items in the tree view that must be modified.

After modifications are complete
You must test modifications to the configuration of a remote site. Complete the 
test suite to ensure that the modifications work properly.

When you are satisfied that your system is working properly, perform a backup.
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Deleting items in the tree view

Introduction
The Messaging Network Configuration tree view contains all sites in your 
messaging network with which the local site exchanges messages.

A site always consists of a messaging server and a prime switch location. A site 
may also include satellite switch locations.

Sites and satellite switch locations are deleted from the Messaging Network 
Configuration tree view.

Note: You cannot delete the local site. You can delete local satellite switch 
locations.

Multi-administrator environments
If several administrators maintain your local network database, ensure that your 
view of the Messaging Network Configuration tree view is up-to-date. The 
Messaging Network Configuration tree view is updated when it is initially 
opened. An open tree view is not updated when another administrator makes 
changes.

To check the status of the view
To see if another administrator has made changes to the Messaging Network 
Configuration tree view, on the View menu, click Refresh.

ATTENTION! When an item is deleted from the Messaging 
Network Configuration tree view, it is permanently 
removed from the local network database. The 
information cannot be recovered. For this reason, it 
is strongly recommended that you print out the 
complete configuration of all items to be deleted. If 
an item is accidentally deleted, you can use the 
printed information to add the item again.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To delete a remote site

1 Print the configuration details of the site that you want to delete.

2 Open the folder of the remote site to see the messaging server, prime 
switch location, and any satellite switch locations.

3 In a multi-administrator environment, on the View menu, click Refresh.

4 Highlight the messaging server of the site that you want to delete.

5 Select File > Delete.

Result: A confirmation message appears asking if you really want to delete 
the site from your local network database.

6 To delete the site, click Yes.

Tip: You can also delete a highlighted remote site by clicking the Delete 
button.

Deleting several remote sites at once
If you must delete several remote sites from the local network database, you may 
find it more efficient to delete all the sites at once.

To delete several remote sites at once

1 Print the configuration details of all the sites that you want to delete.

2 In the tree view, highlight all the remote sites that you want to delete.

Tip: To select more than one item in the tree view, press Ctrl and right-click 
the mouse.

3 Select File > Delete.

Result: A confirmation message appears. 

4 Click Yes to delete the sites. Click No to keep the sites.
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Deleting a satellite switch location
If there are changes to an NMS site, you can delete one or more satellite switch 
locations from the local site or from any remote sites.

If you remove a satellite switch location from an NMS site, you must also 
remove it from the local network database.

To delete a satellite switch location 
Print the configuration details of the satellite switch location.

1 In a multi-administrator environment, on the View menu, click Refresh.

2 Highlight the satellite switch location that you want to delete.

3 On the File menu, click Delete.

Result: A confirmation message appears. 

4 Click Yes to delete the sites. Click No to keep the sites.
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Modifying dialing plan information

Introduction
After you establish a dialing plan, you rarely modify it. Modifications to a 
dialing plan affect users and may require considerable relearning of the system.

However, if modifications are necessary, they are usually guided by changes 
made by the switch technician. These changes can be local or remote.

Switch changes
If any changes to the dialing plan are made on a switch,  the network databases 
of the sites in the messaging network must reflect these changes. If changes are 
made locally, ensure that all remote sites are notified.

To modify the dialing plan information
If you need to modify the dialing plan, follow the general instructions to modify 
the local and remote sites.

Modifying CDP steering codes
Modifications to the CDP steering codes are more complicated. For a detailed 
review of how to plan for and implement changes, consult Chapter 4, “Dialing 
plans and networking,” in the Networking Planning Guide.
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Troubleshooting Integrated AMIS 
Networking

Although testing and regular maintenance ensure that Integrated AMIS 
Networking is working properly, the system may experience occasional 
problems.

This chapter describes how to diagnose and correct these problems.

In this chapter
About troubleshooting Integrated AMIS Networking 257

Determining if problems are switch-related 263
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About troubleshooting Integrated AMIS 
Networking

In this section
Overview 258

Determine if Integrated AMIS is disabled 260

Reviewing Alarm and Event reports 261

Reviewing Operational Measurement reports 262
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Overview

Introduction
If you are experiencing problems with Integrated AMIS Networking, this 
chapter will help you to identify and solve these problems.

Common causes of Integrated AMIS Networking problems include the 
following:

■ Integrated AMIS Networking is disabled.

■ The status of a remote site prevents it from receiving messages from the 
local site.

■ Networking configuration is incorrect or incomplete.

■ The switch is configured incorrectly.

■ There are hardware problems.

Identify the source of the problem
To identify the source of the problem, first determine if Integrated AMIS 
Networking is disabled.

If Integrated AMIS Networking is properly enabled, then review the following:

■ appropriate Alarm and Event reports

■ network status

■ Operational Measurement (OM) reports

Configuration errors
Configuration errors may include the following:

■ incorrect connection DNs

■ message transfer protocols that do not match between the remote and local 
sites

■ incorrect dialing plan information, including ESN prefixes and CDP 
steering codes

■ scheduling parameters that need to be modified
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Site status errors
A site can be either intentionally disabled or put into error status.

A remote site may be put into error status because of unsuccessful attempts by 
the local site to deliver messages to the remote site. Failed message delivery can 
happen for the following reasons:

■ The remote site is experiencing hardware or software problems.

■ There are site configuration errors.

Switch-related problems
If you are unable to identify the problem using CallPilot, the error may be 
switch-related. Perform the call trace test to determine if there is a problem with 
the switch configuration.

Call trace
Call trace helps you to determine if network calls are being blocked for one or 
more of the following reasons:

■ Digit manipulation is performed incorrectly. Either not enough or too many 
digits are inserted or deleted.

■ Class of service restrictions are either too stringent or too loose.

■ Dialing is incorrect. More digits are required by the trunks or trunk routes.

Note: On the switch, you can perform a call trace on a telephone or on a trunk 
and a trunk route.

Hardware problems
If you are unable to locate the problem in the CallPilot networking configuration 
or in the switch, your system may be experiencing hardware problems that are 
not related to networking.

Perform a basic hardware check. Examine all connections.
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Determine if Integrated AMIS is disabled

Introduction
You must enable Integrated AMIS Networking to receive incoming AMIS 
messages and to deliver outgoing AMIS messages.

Begin any troubleshooting session by determining if Integrated AMIS 
Networking is properly enabled.

There are several methods of disabling and enabling the sending and receiving 
of Integrated AMIS Networking messages. 

To determine if Integrated AMIS Networking has been disabled to receive 
incoming messages or to send outgoing messages, or both, check the settings on 
the AMIS 1 tab of the Message Delivery Configuration dialog box.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration

To determine if Integrated AMIS Networking is disabled

1 From the Message Delivery Configuration dialog box, select the AMIS 1 
tab.

2 Check the settings of the Outgoing AMIS Networking and Incoming AMIS 
Networking check boxes. Ensure that these check boxes are selected as 
required for your system.

3 Click Save to exit and save any changes that you made.

If Check this setting

the system does not receive 
incoming messages

Incoming AMIS Networking messages enabled.

the system does not deliver 
outgoing messages

Outgoing AMIS Networking messages enabled.
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Reviewing Alarm and Event reports

Introduction
Alarm and Event reports track and report system errors and unusual events. 
These reports can be viewed on-screen or printed, or both.

Reports related to Integrated AMIS Networking
The following reports are useful for monitoring Enterprise Networking:

■ Networking Activity report

■ Network Usage Bill-back report

■ Failed Networking Sessions alert

See also
For instructions on reviewing and interpreting Alarm and Event reports, consult 
the Reporter Guide.
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Reviewing Operational Measurement reports

OM reports
Operational Measurement (OM) reports contain detailed information on how the 
system is functioning. When you attempt to locate problems with Integrated 
AMIS Networking, review these reports.

When you review the OM reports, consider the following:

See also
For detailed instructions on producing, reviewing, and interpreting Operational 
Measurement reports, consult the Reporter Guide.

This OM result Suggests

large number of accesses the holding time may be too low, or the batch threshold is 
too small.

excessive “Failed to Send” 
messages

the remote system may be down, or the dialing 
translations are incorrectly configured, or the call 
maximum number is too small.

high number of NDNs users are entering incorrect addresses, or mailboxes do not 
exist on the remote system.

networking traffic is 
excessive

an unusual or cyclical event affected the system, or the 
number of channels used by Integrated AMIS Networking 
is too small, or the number of channels available to 
Integrated AMIS Networking is too small.

failures the remote system does not support the AMIS protocol, or 
the number of channels is too small.
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Determining if problems are switch-
related

In this section
Switch-related problems 264

Call trace test 265

Link diagnostic test 267
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Switch-related problems

Integrated AMIS Networking problems and the switch
If you cannot identify the cause of the Integrated AMIS Networking errors using 
CallPilot, the problem may be switch-related.

The following tests identify switch-related problems:

■ call trace

■ link diagnostic
264 CallPilot



October 2003 Troubleshooting Integrated AMIS Networking 
Call trace test

Purpose
If you cannot identify the Integrated AMIS Networking problem using CallPilot, 
calls may be blocked by the switch. The call trace test determines

■ if calls are blocked

■ why calls are blocked

Why calls are blocked
A network call can be blocked for one or more of the following reasons:

■ Digit manipulation is performed incorrectly. Not enough or too many digits 
are inserted or deleted.

■ Class of service restrictions are too stringent or too loose.

■ Dialing is incorrect. More digits are required by the trunks or card trunk 
routes.

Where a call trace is performed
On the switch, you can perform a call trace on a phoneset or on a trunk and trunk 
route.

Before you begin
To interpret the results of a call trace test, you need to understand

■ how the switch processes calls

■ how to interpret the results of a call trace session

Note: A switch technician should perform the call trace test and interpret the 
results.
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The information that is required to perform the call trace test varies for each type 
of switch. However, the following information is usually required:

■ your customer number

■ the directory number that will be tested

■ the type of telephone and key number (for multiline telephones)

■ the terminal number (loop, shelf, card, unit) of the telephone or trunk that 
will be tested

■ the route type and trunk number of the trunk and trunk route that will be 
tested

To perform the call trace test
Follow the instructions in your switch documentation.

How to interpret the results
For guidelines on how to interpret the results of the call trace test, consult your 
switch documentation.
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Link diagnostic test

Purpose
If you cannot identify the cause of the networking problem on the CallPilot or by 
performing the call trace test, the problem may not be related to networking.

The link diagnostic test determines if the link between the switch and the 
Meridian Application Server is working.

Before you begin
The link diagnostic must be performed by a switch technician.

To perform the link diagnostic test
Follow the instructions in your switch documentation.
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remote messaging server, 251
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location, 197
configuring CDP information, 171
configuring CDP information for a remote 

prime switch location, 193

configuring ESN information for a remote 
prime switch location, 190

configuring parameters, 135
configuring the local server, 157
definition, 46
determining if disabled, 260
diagram, 46
directory number, 116
disabling, 128, 238
enabling, 128, 238
end-to-end test, 210
features, 51
gathering information, 90
how it works, 71
how to disable, 239
how to enable, 239
how to modify an SDN, 244
how to modify message delivery parameters, 

242
implementation in a complex messaging 

network, 60
implementation overview, 56
in complex network, 49
information validation, 58
internal controls, 74
local site configuration, 152
maintaining, 226
message contents, 62
message handling, 62
modifying channel resource allocation, 243
modifying configuration, 234
modifying message delivery parameters, 241
parameters, 64
performing backups, 222
phantom DN, 117
preliminary requirements for configuration, 

146
protocol used, 47
relationship to AMIS, 48
relevant OM reports, 232
switch configuration required, 104
switch requirements, 104
switch settings required, 96, 116
switch-related problems, 264
testing, 59
troubleshooting, overview, 258
Integrated AMIS Networking Implementation and Administration Guide 277



Index Standard 1.0
Integrated AMIS Networking test suite, 210
call routing test, 210
local or quick SDN test, 210
loopback test, 211

integrated, defined, 48

L
legal delivery times for AMIS messages, 70, 

134
link diagnostic test, 267
local AMIS system access number, 128
local messaging server name, 152
local prime switch location

configuration if NMS local site, 159
configuration if other networking solution 

implemented, 159
configuration overview, 159
configuration procedure, 163
description, 161
dialing plan information, 162
Enterprise Location ID, 161
mailbox prefix, 163
name, 161
Prime Switch Location Properties dialog box, 

160
recording spoken name, 162

local SDN test
evaluating results, 214
procedure, 213
purpose, 210

local server
configuration if another networking solution 

implemented, 153
configuration overview, 154
configuration process, 157
description, 155
FQDN, 157
name, 155
server type, 155

local site name, 152, 155
local site, configuring, 152
locating remote site, 247
location code

ESN, 166

overlap, 167
loopback mailbox

creating, 141
description, 140
requirements, 140
using, 141

loopback test
evaluating results, 218
procedure, 217
purpose, 211

M
mailbox addressing follows dialing plan, local 

prime switch location, 162
mailbox addressing, dialing plan follows for 

remote prime switch location, 187
mailbox prefix

local prime switch location, 163
remote prime switch location, 188

mailbox, loopback, 140
main steps in implementation, 57
maintenance

as-required tasks, 226
backups following, 227
overview, 226
regularly scheduled tasks, 226

Meridian Mail system, remote site, 205
message

body contents, 62
configuration for using priorities, 63
handling scenario, 80
header contents, 62
parts, 62
priorities, 63
transfer process, 80

Message Delivery Configuration dialog box
AMIS 1 tab, 127
AMIS 2 tab, 131, 132
Standard stale time, 129
Urgent stale time, 129

message delivery parameters
configuring, 135
overview, 126
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message delivery parameters, modifying 
configuration, 241

message handling, 76
message priority, setting default, 84
Message Subject (Text), 53
Message Transfer Agent (MTA), description, 74
message transfer protocol, modifying, 249
message transfer, main steps, 75
messages sent while system disabled, 238
Messaging Administration Properties dialog box

Networking Loopback Mailbox, 140
messaging network, 146
Messaging Network Configuration tree view, 

adding sites, 146
messaging network representation, 58

benefits, 99
coordination with other sites, 99
diagram, 98
overview, 98
security, 99
spreadsheet, 98

migration guides, 18
modifying

channel resource allocation, 243
configuration of Integrated AMIS 

Networking, 234
connection DN, 249
dialing plan, 249, 254
Enterprise Site ID, 249
Integrated AMIS Networking, announcing, 

237
message delivery parameters, 241
message transfer protocol, 249
remote site, 245

modifying remote site, 245
configuration, 248
impact, 248
preliminary requirement, 245

modifying remote site, impact on network 
database, 246

MTA (Message Transfer Agent), description, 74
MTA Monitor, description, 75
multi-administrator environment, deleting items 

from tree view, 251
Multiple Recipients, 52

N
name

local prime switch location, 161
remote prime switch location, 185

Name Addressing, 51
Name Dialing, 51
name of a remote site, 176
name of the local server, 155
name of the local site, 152
Names Across the Network, 51, 156
network administrator, defined, 48
network database, impact of modifying remote 

sites on, 246
network history

contents, 228
overview, 228
security, 228

network protocol used with a remote site, 180
network representation

overview, 98
using to add and configure a remote site, 174

Network Usage Bill-back report, 232
networking

documentation, 20
Networking Loopback Mailbox, 140
networking solutions

configuration if implemented, 147
order of implementation, 60

NMS local site, configuring local prime switch 
location, 159

NMS site
spoken name imported for, 201
spoken name recorded for, 199

non-CallPilot system
remote sites, 203
server type, 204

Norstar Voice Mail, remote site, 206

O
OM reports

importance of reviewing, 232
relevant for Integrated AMIS Networking, 

232
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restricted access, 232
online guides, 22
online Help, accessing, 22
Open AMIS boxes on screens, 123
Open AMIS compose prefix, 69, 133
Open AMIS delivery times, 70, 134
Open AMIS parameters, 68
Open Networking Activity report, 232
open, defined, 48
order of implementation, recommended, 60
outbound service directory number (SDN), 112
overlap

CDP steering code, 170
ESN location code, 167

P
parameters

AMIS Networking, 68
default values, 64
importance, 68
Integrated AMIS Networking, 64
overview, 68
set during implementation, 64

Personal Distribution Lists, 51
phantom DN

how to select, 117
relationship to service directory number 

(SDN), 108
required by Integrated AMIS Networking, 

117
ways to create, 118

planning guides, 18
prefix

compose, 133
mailbox, 163

Prime Switch Location Properties dialog box, 
160

CDP tab, 161
ESN tab, 160
General tab, 160
SMTP/VPIM tab, 161

printing configuration information, 229
priorities of messages, 63
Private Tag, 52

protocol, AMIS Networking, 47
protocol, used with a remote site, 180

Q
quick SDN test

evaluating results, 215
procedure, 215
purpose, 210

R
Received Time Announced, 53
receiving message text information, 157
Recipient’s Name (Text), 53
recording a spoken name, 200
regularly scheduled maintenance tasks, 226
remote messaging server

configuration if another messaging solution 
implemented, 175

configuration overview, 175
connection DN, 181
deleting, 251
Enterprise Site ID, 179
name, 176
network protocol used, 180
sending local user information to, 178
sending message text information, 179
sending messages to a remote site, 177
server FQDN, 179
server types supported, 177

Remote Messaging Server Properties dialog box
Connections tab, 180
General tab, 176

remote prime switch location
CDP information, 192
configuring, 188
configuring ESN information, 190
dialing plan for dialing to this location, 187
dialing plan information, 187
Enterprise Location ID, 186
ESN information, 189
mailbox addressing follows dialing plan, 187
mailbox prefix, 188
name, 185
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spoken name recorded, 186
Remote Prime Switch Location Properties 

dialog box
CDP tab, 184
ESN tab, 184
General tab, 185
SMTP/VPIM tab, 184
tabs, 184

remote satellite switch location
configuration overview, 195
configuring, 197
dialing plan, 196
spoken name recorded, 196

Remote Satellite Switch Location Properties 
dialog box

CDP tab, 195
ESN tab, 195
tabs, 195

remote site
adding, 245
adding and configuring, 174
adding, modifying, and deleting, 245
coordinating information, 72
deleting, 246, 251
how to delete, 252
how to modify configuration, 250
if other networking solutions implemented, 

147
impact of modification, 248
information required to add and configure, 

174
locating, 247
main steps to add and configure, 174
Meridian Mail system, 205
modifying, 245
modifying configuration, 248
name, 176
non-CallPilot, 203
Norstar Voice Mail system, 206
using network representation to add and 

configure, 174
Remote Site Spoken Names, 52
remote switch location

configuration overview, 184
information required, 95
spoken name, 199, 201

Remote Switch Location Properties dialog box, 
General tab, 184

Reply All, 52
Reply To, 52
reports for Integrated AMIS Networking, 261
restricting message exchange, 156
restricting sending messages to a remote site, 

177
Restriction/Permission Lists

assigning for AMIS Networking, 86
creating, 86
purpose, 86

reviewing Alarm and Event reports, 261
reviewing OM reports, 232

what to look for, 262

S
satellite switch location

configuring remote, 195
deleting, 251

scheduling backups, 222
SDN. See service directory number
Sender’s Department, 53
Sender’s Name (Text), 53
sending local user information to a remote site, 

178
sending message text information to a remote 

site, 179
sending messages to other sites, 155
Sent Time Announced, 53
server FQDN, 157

local SMTP/VPIM server, 152
remote site, 179

server type
local server, 155
non-CallPilot remote sites, 204
supported for remote messaging server, 177

service directory number (SDN)
adding and configuring new, 113
and DN setting on switch, 107
definition, 106
examples, 109
how to modify, 244
inbound, 106, 112
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outbound, 106, 112
relationship to other numbers, 107
sharing existing inbound, 114

Service Directory Number (SDN) Table
description, 106
example, 107

Shared Distribution Lists, 52
site status errors, 259
SMTP/VPIM server FQDN, 152
SMTP/VPIM tab

Prime Switch Location Properties dialog box, 
161

Remote Prime Switch Location Properties 
dialog box, 184

speech recognition channel type, 108
Speech Recognition Messaging CDN queues, 

116
spoken name

for remote switch location, 199, 201
importing, 201, 202
importing for local NMS site, 201
recorded for remote satellite switch location, 

196
recording, 200
recording for local NMS site, 199
recording for local prime switch location, 162
recording overview, 199

spoken name recorded
remote prime switch location, 186
ways to record, 186

spreadsheet of messaging network, 98
stale time

description, 66, 129
relationship to holding time, 130

stale time for economy messages, default, 124
stale time for standard messages, default, 124
stale time for urgent messages, default, 124
standard message, holding time, 65
standard priority messages, 63
standard stale time, 129
start and stop times, economy messages, 69
steering code for CDP, 170
switch

and directory numbers (DNs), 116
backup, 222
configuration changes, 254

configuring for Integrated AMIS 
Networking, 58

confirming settings, 92
dialing plan information required, 91
gathering information, 91
gathering information directly from, 91
how an Integrated AMIS message is treated, 

104
information required from, 93
information to gather, 57
Integrated AMIS Networking requirements, 

104
mandatory requirements, 96
setting required for Integrated AMIS 

Networking, 116
switch-related problems, 264

call trace, 259
call trace test, 265
link diagnostic test, 267

system access number
coordinating information, 72
private network, 129
public network, 128
purpose, 128
relationship to connection DN, 71

T
technical support, 23
terms used in this guide, 48
test suite

call routing test, 210
end-to-end test, 210
local SDN test, 210
loopback test, 211
purpose, 210
quick SDN test, 210
tests included, 210

testing Integrated AMIS Networking, 59
compliance of third-party systems, 210
coordination required, 211
ensuring quick results, 211

testing with loopback mailbox, 141
text information in messages, 157
third-party systems, testing compliance, 210
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Timed Delivery, 53
tree view, deleting items from, 251
troubleshooting

reference documentation, 22
technical support, 23

troubleshooting Integrated AMIS Networking
configuration errors, 258
hardware problems, 259
identifying problem, 258
overview, 258
site status errors, 259
switch-related problems, 259

U
urgent messages, 63

holding time, 65
Urgent stale time, 129
Urgent Tag, 52
user guides, 21
User’s Actual Personal Verification, 52
using a loopback mailbox, 141

V
validation of information, 58
Virtual Node AMIS, terminology note, 203
virtual node, replaced by integrated, 48
voice channel type, 108
Voice Messaging CDN queue, 116
VPIM Networking, server FQDN of remote site, 

179

W
ways to disable Integrated AMIS Networking, 

239
ways to enable Integrated AMIS Networking, 

239
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